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Preface

This documentation describes how to create the metadata for the data sources that your
WebFOCUS projects will access. It is intended for database administrators, application
developers, or other information technology professionals who will create the metadata used
by WebFOCUS to access corporate data.

How This Manual Is Organized

This manual includes the following chapters:

ContentsChapter/Appendix

Introduces data source descriptions and explains
how to use them.

Describing and Accessing
Data: Overview

1

Describes how to create a synonym for your data
source description.

Accessing Data and
Creating Synonyms

2

Describes the Synonym Editor and how you may use
it to view and edit synonyms in Developer Studio.

Using the Synonym Editor3

Describes how to analyze procedures using Impact
Analysis, and how to view Data Profiling for the
columns in a synonym.

Analyzing Metadata and
Procedures

4

Describes utilities to create new FOCUS data sources
and to refresh existing data sources after the
structure has changed.

Adding Data and Rebuilding
FOCUS Data Sources

5
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Documentation Conventions
The following table lists and describes the conventions that apply in this manual.

DescriptionConvention

Denotes syntax that you must enter exactly as shown.THIS TYPEFACE

or

this typeface

Represents a placeholder (or variable) in syntax for a
value that you or the system must supply.

this typeface

Indicates a default setting.underscore

Represents a placeholder (or variable), a cross-
reference, or an important term. It may also indicate a
button, menu item, or dialog box option you can click
or select.

this typeface

Highlights a file name or command.this typeface

Indicates keys that you must press simultaneously.Key + Key

Indicates two or three choices; type one of them, not
the braces.

{  }

Indicates a group of optional parameters. None are
required, but you may select one of them. Type only
the parameter in the brackets, not the brackets.

[  ]

Separates mutually exclusive choices in syntax. Type
one of them, not the symbol.

|

Indicates that you can enter a parameter multiple times.
Type only the parameter, not the ellipsis points (...).

...

Indicates that there are (or could be) intervening or
additional commands.

.

.

.
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Related Publications
To view a current listing of our publications and to place an order, visit our Technical
Documentation Library, http://documentation.informationbuilders.com. You can also contact
the Publications Order Department at (800) 969-4636.

Customer Support
Do you have questions about this product?

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212) 736-
6130. Customer Support Consultants are available Monday through Friday between 8:00
A.M. and 8:00 P.M. EST to address all your questions. Information Builders consultants can
also give you general guidance regarding product capabilities and documentation. Be prepared
to provide your six-digit site code (xxxx.xx) when you call.

You can also access support services electronically, 24 hours a day, with InfoResponse
Online. InfoResponse Online is accessible through our World Wide Web site,
http://www.informationbuilders.com. You can connect to the tracking system and known-
problem database at the Information Builders support center. Registered users can open,
update, and view the status of cases in the tracking system and read descriptions of reported
software issues. New users can register immediately for this service. The technical support
section also provides usage techniques, diagnostic tips, and answers to frequently asked
questions.

To learn about the full range of available support services, ask your Information Builders
representative about InfoResponse Online, or call (800) 969-INFO.

Information You Should Have
To help our consultants answer your questions effectively, be prepared to provide the following
information when you call:

Your six-digit site code (xxxx.xx).

Your WebFOCUS configuration:

The front-end you are using, including vendor and release.

The communications protocol (for example, TCP/IP or HLLAPI), including vendor and
release.

The software release.

Your server version and release. You can find this information using the Version option
in the Web Console.
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The stored procedure (preferably with line numbers) or SQL statements being used in
server access.

The Master File and Access File.

The exact nature of the problem:

Are the results or the format incorrect? Are the text or calculations missing or
misplaced?

The error message and return code, if applicable.

Is this related to any other problem?

Has the procedure or query ever worked in its present form? Has it been changed recently?
How often does the problem occur?

What release of the operating system are you using? Has it, your security system,
communications protocol, or front-end software changed?

Is this problem reproducible? If so, how?

Have you tried to reproduce your problem in the simplest form possible? For example, if
you are having problems joining two data sources, have you tried executing a query
containing just the code to access the data source?

Do you have a trace file?

How is the problem affecting your business? Is it halting development or production? Do
you just have questions about functionality or documentation?

User Feedback
In an effort to produce effective documentation, the Documentation Services staff welcomes
your opinions regarding this manual. Please use the Reader Comments form at the end of
this manual to communicate suggestions for improving this publication or to alert us to
corrections. You can also use the Documentation Feedback form on our Web site,
http://documentation.informationbuilders.com/feedback.asp.

Thank you, in advance, for your comments.

Information Builders Consulting and Training
Interested in training? Information Builders Education Department offers a wide variety of
training courses for this and other Information Builders products.

For information on course descriptions, locations, and dates, or to register for classes, visit
our World Wide Web site (http://www.informationbuilders.com) or call (800) 969-INFO to
speak to an Education Representative.
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Describing and Accessing Data: Overview1
Topics:

Developer Studio provides a set of
graphical tools that you can use to
describe and access many types of data
sources, including:

A Note About Data Source Terminology

How Applications Interpret Data
Relational, such as DB2, Oracle,
Sybase, Informix, and JDBC. How to Obtain a Synonym

What You Can Do With a SynonymMulti-dimensional, such as SAP BW
and Essbase. Ways to Enhance a Synonym

Procedures, such as Web Services
and CICS Transactions.

How an Application Uses a Synonym

Alternative Tools on the Reporting
Server ConsoleXML, such as XML and Tamino.

Hierarchical, such as IMS and FOCUS.

Sequential, both fixed-format and
free-format.

Indexed, such as ISAM and VSAM.

Network, such as CA-IDMS.

Other popular data sources, such as
Lotus Notes and LDAP.

These graphical tools are designed to:

Translate the schema of the data
source into metadata that WebFOCUS
can read and report against.

Optionally, enable you to customize
and enhance the generated
metadata, without having to know the
subtleties of the underlying
WebFOCUS data description
language.
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A Note About Data Source Terminology
Different types of data sources make use of similar concepts, but refer to them differently.
For example, the smallest meaningful element of data is called a field by many hierarchical
database management systems and indexed data access methods, but called a column by
relational database management systems.

There are other cases in which a common concept is identified by a number of different
terms. For simplicity, we have standardized on a single set of terms. For example, we usually
refer to the smallest meaningful element of data as a field, regardless of the type of data
source. However, when required for clarity, we use the term specific to a given data source.
Each time we introduce a new standard term, we define it and compare it to equivalent terms
used with different types of data sources.

How Applications Interpret Data
When your application accesses a data source, it needs to know how to interpret the data
that it finds. To accomplish this it reads a synonym, which is an Information Builders’ term
for the generated metadata associated with the particular data source.

Your application needs to know about:

The overall structure of the data. For example, is the data relational, hierarchical,
multi-dimensional, sequential? Depending upon the structure, how is it arranged or
indexed?

The specific data elements. For example, what fields are stored in the data source, and
what is the data type of each field—character, date, integer, or some other type?

The synonym provides an alias for the data source that tells the server how tables are
described and where to find them.

The primary component of a synonym is a Master File. The Master File describes the structure
of a data source and its fields. For example, it includes information such as field names
and data types.

For some types of data sources, an Access File supplements the Master File. An Access
File includes additional information that completes the description of the data source. For
example, it includes the full data source name and location. The nature of the information
in the Access File is specific to each data source. You need one Master File—and, for some
types of data sources, one Access File—to describe a data source.

10 WebFOCUS7
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How to Obtain a Synonym

Reference:

How an Adapter Works

You can generate synonyms using Developer Studio's Create Synonym tool , which enables
you to explore DBMS catalogs and select the objects for which you wish to create synonyms.
The tool prompts for all the information it needs to create a synonym for a particular data
source and stores the generated synonym on the server.

The Create Synonym tool is fully described in Accessing Data and Creating Synonyms on page
15.

There are some prerequisites: you must be authorized to use the data against which you
plan to report and you must have configured an adapter to access that type of data. In fact,
when you begin to create a synonym, Developer Studio opens the adapter configuration
window. The option to create the synonym becomes available only after the adapter is
successfully configured.

Adapters are available for many data sources. Every adapter is specifically designed for the
data source that it accesses, and, as a result, is able to translate between SQL or WebFOCUS
and the data management language (DML) of the data source. Adapters provide solutions
to product variations, including product differences in syntax, functionality, schema, data
types, catalogs, data representations, message processing, and answer set retrieval. It is
the adapter that manages the synonym creation process. For related information, see How
an Adapter Works on page 11.

The parameters required to configure over 60 supported adapters and to create synonyms
for the corresponding data sources are described in detail in the Adapter Administration for
UNIX, Windows, OpenVMS, i5/OS, and z/OS manual.

How an Adapter WorksReference:

The adapter manages the communication between the data interface and the data source,
passing data management requests to the data source and returning either answer sets or
messages to the requestor. To perform these functions, the adapter:

Translates the request to the applicable DML.

Attaches to the targeted data source, using standard attachment calls. The adapter then
passes the request to the data source.

The data source processes the request.

The results or error conditions are returned to the client application for further processing.

Describing Data with Graphical Tools 11
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What You Can Do With a Synonym
Once you have generated a synonym, you can report against it using all of Developer Studio's
reporting tools. In many instances, the configured adapter and the generated synonym are
all you need to access your data and create reports and graphs.

However, you may wish to enhance the synonym in order to implement particular capabilities
that are supported in the WebFOCUS data description language. To do this, you can use a
second data description tool, the Synonym Editor.

When you use the Synonym Editor, there is no need to know the data description language
since the graphical tool displays all viewable and editable attributes of the synonym
components. If you make changes to the generated synonym, the Synonym Editor validates
your entries and displays messages if they violate the underlying syntax of the data description
language.

Note: If you are comfortable working directly with code, you can open the synonym
components in a text editor. While the text editor does some error checking, we cannot
guarantee that code which is altered manually will be syntactically correct, so we urge you
to use the text editor as a viewing tool, and to make your enhancements through the graphical
Synonym Editor interface. For detailed information about the underlying syntax, see the
Describing Data With WebFOCUS Language manual.

Ways to Enhance a Synonym
Here are just a few of the attributes you might want to add to the synonym to enhance your
data access and reporting capabilities. You can:

Create a cluster Join view by linking available synonyms to create a multi-segment
(multi-table) file for reporting.

Apply security rules for fields and values to ensure that user access is based on
Information Builders data source security (DBA) specifications.

Add dimensions for OLAP analysis.

Add virtual columns (DEFINEs) and columns for aggregated values (COMPUTEs).

Add filters to specify data selection criteria.

Add group definitions for data sources that support groups.

Add meaningful titles and descriptions, including Multilanguage variations.

Change the format of fields (for example, the size of an alpha field or the format of a
date field).

12 WebFOCUS7
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Create business views of the metadata in order to limit the fields available to any retrieval
request that references the business view and to group fields together based on their
roles in an application.

Define parent/child hierarchies for cube data sources such as SAP BW and Essbase.

The Synonym Editor is fully described in Using the Synonym Editor on page 51.

How an Application Uses a Synonym
Synonyms are stored separately, apart from the associated data source. Your application
uses a synonym to interpret the data source in the following way:

1. It identifies, locates, and reads the Master File for the data source named in a request.

2. It locates and reads the Access File for the data source named in the request, if that
type of data source requires an Access File.

3. It locates and reads the data source(s).

The data source contents are interpreted based on the information in the synonym.

Alternative Tools on the Reporting Server Console
If you prefer to work in a thin-client Web environment, you can access alternative tools on
the Reporting Server Console (also called the Web Console) from Developer Studio. The
Reporting Server Console enables you to configure adapters, create and enhance synonyms,
and perform a wide range of other server-related tasks.

Although the look and feel of the Reporting Server Console is different from the Developer
Studio interface, the options on the corresponding tools are largely identical. However, a
few options that are currently supported in Developer Studio are not supported on the Web
Console at the present time. These include:

Defining hierarchies for cube-based data sources, such as SAP BW and Essbase.

Adding dimensions for OLAP Analysis.

Creating business views of your data.

Procedures for accessing the Reporting Server Console, configuring adapters and remote
servers, and creating synonyms are described briefly in Accessing Data and Creating Synonyms
on page 15  and extensively in the Adapter Administration for UNIX, Windows, OpenVMS,
i5/OS, and z/OS manual.
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Accessing Data and Creating Synonyms2
Topics:

Before you can create a procedure that
reports against a data source, your
application must be able to access the
data and understand how the data is
organized. To obtain this information,
your application reads a synonym, which
generally consists of two files:

Configuring Adapters and Remote
Servers in Developer Studio

Creating Synonyms in Developer
Studio

Defining a Remote Server in the
WebFOCUS Client Communication File

A Master File that describes the
data so WebFOCUS can report on it.
This file contains field names and
formats for the columns in the data
source. The synonym also contains
an alias for the data source.

An Access File that contains
additional information needed by
WebFOCUS to access data. This
information, which is required by
many data sources, includes the data
source's real name and location.

Often, a synonym already exists on the
server, and reporting can begin at once.
However, if the synonym you need does
not exist on the server, an authorized
server or application administrator can
create it directly from Developer Studio
using the Create Synonym tool.

Describing Data with Graphical Tools 15



Configuring Adapters and Remote Servers in Developer Studio

In this section:

Data Access Configuration Variations

Configuring Adapters in Developer Studio

This chapter focuses primarily on the WebFOCUS Environments, Data Servers area of the
Developer Studio Explorer, where you can access data and develop applications directly on
a remote WebFOCUS Reporting Server using Developer Studio tools. The chapter describes
the graphical tools that enable you to access data and create metadata, as well as several
configuration variations that affect your selection and use of these tools.

Project-area options for data access and development are described in the Developer Studio
Application Development Getting Started manual and all aspects of Managed Reporting
administration are described in the Managed Reporting Administrator’s Manual . Note,
however, that the procedures for accessing data and creating synonym for use in the Projects
and Managed Reporting environments are similar to those described in this chapter for
WebFOCUS Environments.

16 WebFOCUS7
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Let's begin by examining the WebFOCUS Environments, Data Servers area of Developer
Studio Object Explorer.

The Data Servers area displays each WebFOCUS Reporting Server that the WebFOCUS Client
can access and permits development against multiple Reporting Servers, which may be
configured on any supported platform (as illustrated in the previous image).

The Data Servers folder is always accessible from the Developer Studio Object Explorer. It
lists the applications you have access to and the resources (files) stored in these
applications.

The default WebFOCUS Reporting Server (named EDASERVE by default) is created during
installation and is displayed in the Data Servers area.

Describing Data with Graphical Tools 17
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In the previous image, notice that several remote servers have been added. An Applications
folder beneath each WebFOCUS Reporting Server displays the directories based on the
Application Root directory (APPROOT) for that WebFOCUS Reporting Server (on Windows,
drive:\ibi\apps by default). For this example, a server called FLATIRON (UNIX Dev. WF
Reporting Server) is shown with its Applications folder expanded. Any directory located under
APPROOT appears under the Data Servers Applications folder. In addition, you can map an
application that is not under APPROOT (but resides elsewhere in the file system) to be
accessible as a virtual application. The mapped application is displayed for use, along with
the applications that are physically under approot.

The Data Servers area gives you access to the file resources on all WebFOCUS Reporting
servers in your environment. You can create and manage metadata, procedures, html files,
and WebFOCUS StyleSheets. You can also perform operations on GIF images and other
files, such as FOCUS data sources. For organizational purposes, these application files are
displayed in virtual folders labeled HTML Files, Master Files, Procedures, etc.

The virtual folders appear this way by default. However, if you wish, you can hide the virtual
folders from the Object Explorer tool bar.

If you are developing applications using a remote WebFOCUS Environment, you must first
set up your environment to be able to create synonyms (Master and Access Files) and access
the associated data on a remote WebFOCUS Reporting Server. For details about how, when,
a where to create this metadata, see Data Access Configuration Variations on page 19.

18 WebFOCUS7
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Data Access Configuration Variations

How to:

Access the Create Synonym Tool

If you are working on the platforms served by Developer Studio (UNIX, Windows, OpenVMS,
i5/OS, and z/OS), you can use Developer Studio's Create Synonym tool to set up access
to your data. This process involves configuring adapters, adding remote servers if necessary,
and then creating the required synonyms.

Tip: Authorized administrators who prefer to work in a thin client environment can complete
these tasks from the Reporting Server Web Console, which is accessible from the Develop
Studio's Object Explorer toolbar. Both approaches edit the same underlying server files, so
it does not matter which you use. For more information, see Using the Reporting Server Web
Console for Data Access and Synonym Preparation on page 41.

Configuring adapters. An adapter enables an application to access a data source. Each
type of data source requires its own adapter to properly convert data or application
requests into native statements and return optimized answer sets to the requesting
program.

For example, if you wish to report against data in an Oracle database, you need to
configure the Adapter for Oracle, which enables you to create the synonyms you need to
access and read your Oracle data. To access Microsoft SQL Server data, you need to
configure the Adapter for Microsoft SQL Server, and so on. An adapter must be configured
on each Reporting Server that accesses the corresponding type of data.

For details, see Configuring Adapters and Remote Servers in Developer Studio on page
16.

Adding remote servers to your server configuration (If needed).

In order to understand when this step is required, it is useful to start by understanding
when it is not required. If you have configured adapters and your data is directly accessible
from your default WebFOCUS Reporting Server, as represented in the following diagram,
a remote server has no role in your configuration.

Describing Data with Graphical Tools 19
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With this setup, once adapters are available on the default WebFOCUS Reporting Server,
you can create the required synonyms. (The same is true if you are working in the Projects
area from a standalone Developer Studio installation, where a default Reporting Server
is automatically available on your local machine.)

Remote servers are required in the following situations:

At many sites, some of the data that applications need to access resides on another
server or servers, often referred to as remote servers. The following are typical
configurations.

For the most frequently used remote server setup, sites require that each remote server
be available as a distinct, named server (for example, FLATIRON and HERMES and
previously shown Object Explorer illustrations), which is visible in and accessible from
the Data Servers area. This permits application development and/or administration and
metadata management directly against the individual remote Reporting Servers.

This modular server configuration provides great flexibility for in-place development on
various types of application resources using Developer Studio tools. For example, if a
self-service application resides on the FLATIRON UNIX server, you may want to edit some
of its components (maybe a procedure or an html file) directly on that server, or you may
want to take advantage of Developer Studio's graphical tools to work with application
files on a Mainframe server, such as PDS_SRV1 or USS_SRV2.

20 WebFOCUS7
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In this situation, you must add the server(s) to your default Reporting Server's
configuration, but you must also specify the same server(s) in your WebFOCUS Client
configuration because that is what adds the distinct server names to the Data Servers
folder. Only then can you perform operations directly on those servers. This includes
creating synonyms and using Developer Studio tools to work with application files
(synonyms, procedures, html files, etc.) organized by application under each remote
server.

To expedite the client-side remote server configuration, you can access the WebFOCUS
Administration Console directly from Developer Studio. For details about adding servers
to the WebFOCUS Client configuration, see How to Add a Remote Server to the WebFOCUS
Environment on page 43.

Keep in mind, however, that in order to use the data on each of these remote servers,
the appropriate adapters and synonyms must exist on those servers. Sometimes they
are already available there, but if not, you must configure the adapters and generate the
synonyms, as described later in this chapter.

In another common remote server implementation, some of the data that applications
need to access resides on another server or servers, which are accessible through the
default WebFOCUS Reporting Server.

In this case, you must add each remote server to your default Reporting Server's
configuration before you can create synonyms that point to tables on the remote server(s)
and report against the combined data (which can be of different types and even on
different platforms).

This assumes, however, that the required synonyms already exist on the remote servers.
If that is not the case, you must first create synonyms for the data accessed by the
remote servers, which may, in turn, require configuring the adapter needed to create
those synonyms.

Describing Data with Graphical Tools 21
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Once your default Reporting Server (e.g., EDASERVE) can communicate with the remote
servers and access the data stored there, you can use Developer Studio tools to work
with various types of application resources (Master Files, procedures, html files, etc.),
organized for your convenience in virtual folders under each application.

It is important to note that in this setup the remote servers do not appear in the Data
Servers folder. Since they can only be accessed through the default Reporting Server,
they are not exposed as separate servers in Developer Studio.

Creating synonyms for use by your applications in any supported environment. (The
synonyms you create are stored in your Reporting Server repository, as defined by
APPROOT.)

For each data source the server will access, you must create a synonym that describes
the structure of the data source and the server mapping of its data types.The synonyms
define unique names (or aliases) for each table, view, or other type of object that is
accessible from the server.

Synonyms are useful because they hide the underlying data source's location and identity
from client applications. They also provide support for extended metadata features of
the server, such as virtual fields and additional security mechanisms. Using synonyms
allows an object to be moved or renamed while allowing client applications to continue
functioning without modification. The only modification required is a redefinition of the
synonym on the server. The result of creating a synonym is a Master File and, usually, a
corresponding Access File, which represent the server's metadata.

Appropriate synonyms must be available on the server where the data resides.

For details, see Creating Synonyms in Developer Studio on page 33.

How to Access the Create Synonym ToolProcedure:

To launch the Create Synonym tool from the WebFOCUS Environments area of the Explorer:

1. Expand your WebFOCUS environment (for example, FLATIRON---UNIX Dev. WF Reporting
Server), expand Data Servers, expand the server, expand the Applications folder, expand
an application, and right-click the Master Files folder for the application in which you
wish to access the data source.

If you wish to use the data source in multiple applications, or have not yet created your
application, you can use the baseapp application, where resources can be stored for
sharing and access by other applications.

Tip: If you are developing from the Projects area of the Explorer, expand the project, and
right-click the Master Files folder, then proceed as described.
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2. Select New and then Synonym.

The Create Synonym tool opens. By default, no adapters are available. Your first task
is to configure an adapter in order to be able to access a relational, multidimensional,
or other type of data source.
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Note: If any adapters have already been configured for the server you will not see this
message. Instead, you will see the available adapters, from which you can immediately
begin to create synonyms.

3. In this instance, we are assuming that no adapters are available. Click the Configure
Adapters button at the bottom right to start the configuration process.
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The Manage and Configure Data Adapters window opens.

Depending upon your needs, you can use this Window to start configuring an adapter,
adding a remote server, or both.

Configured. This folder contains any data adapters or remote servers that are already
configured. By default, when Developer Studio is installed on its own, the Configured
folder displays a Remote Servers folder that contains EDASERVE, the default
WebFOCUS Reporting Server.

You can use the Configured folder to add new connections for existing data adapters
or servers, edit existing data adapters or servers, or create synonyms.

Note that this folder will not initially be visible for a WebFOCUS installation; it becomes
visible only after an adapter or a remote server has been explicitly configured.

Add Adapter Configuration. This folder lists the data adapters that you can configure
on the WebFOCUS Reporting Server platform.
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Configuring Adapters in Developer Studio

How to:

Configure an Adapter in Developer Studio

Add a Remote Server in Developer Studio

If your machine has access to your data sources, you can configure adapters to access data
directly. However, some adapters may require you to configure your environment before
adding them. To determine if this is required for an adapter you wish to configure, refer to
the Adapter Administration for UNIX, Windows, OpenVMS, i5/OS, and z/OS manual.

When you configure an adapter, information is added to the server's edasprof.prf and
edaserve.cfg files.

How to Configure an Adapter in Developer StudioProcedure:

This procedure assumes that you have opened the Create Synonym tool and clicked the
Configure Adapter button to access the Manage and Configure Data Adapters window. You
are now ready to proceed as described below:

1. Expand the Add Adapter Configuration folder in the Manage and Configure Data Adapters
window.

2. Expand folders to select from the list of available adapters and select an adapter to
configure.

3. Click the Configure button to add the selected adapter.

Fields for defining the adapter appear.

4. Complete the form for your adapter.

Tip: If you need information about these fields, refer to the Server Console help, which
you can access by choosing WebFOCUS Reporting Server Console from the Command
menu. The Server Console opens. Click Help on the menu bar, select Contents and
Search, expand the Adapters topic in the Table of Contents pane, and look for the adapter
you are configuring. (This is the same information contained in the Adapter Administration
for UNIX, Windows, OpenVMS, i5/OS, and z/OS manual.)

5. Click Configure.

A message from the Reporting Server confirms that the adapter has been added to your
configuration.

6. Click Continue to return to the Manage and Configure Data Adapters window.

A folder for your adapter should appear under Configured.
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7. Expand your adapter's folder and click the connection you defined.

The Create Synonym, Test, Delete, and Properties buttons appear.

8. Click Test to test the connection.

If you typed the correct connection parameters, sample data should appear.

If the test fails, click the connection, choose Properties, and adjust your information
accordingly.

9. When sample data appears, click Close.

How to Add a Remote Server in Developer StudioProcedure:

This procedure assumes that you have opened the Create Synonym tool and clicked the
Configure Adapter button to access the Manage and Configure Data Adapters window. You
are now ready to proceed as described below:

1. Expand the Configured folder in the Manage and Configure Data Adapters window of the
Create Synonym tool.

Note: If you do not see the Configured folder, expand Add Adapter Configuration instead.

2. Instead of choosing an adapter from the list, select Remote Servers and choose Add
connection or Configure.
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A window appears containing fields to define the connection.

3. Complete the fields as follows:

DescriptionBasic
Parameters

Type a name by which you will refer to the server. The name is your
choice, but cannot be the same as any other server. It must begin
with a letter and cannot be more than eight characters.

NODE

Specify the hostname or IP Address for the server.HOST

Specify the base TCP port for the server. The default is normally
8120, not 8100.

PORT

Specify the HTTP port for the server. This is normally one more
than the base TCP port. The default is normally 8121, not 8101.

HTTP_PORT

If this is a z/OS server, you must include a qualifier. (Pertains only
to z/OS servers.)

CLASS
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DescriptionBasic
Parameters

Specify how a user should log on to the remote server:

IWA(Integrated Windows Authentication; Windows only) Passes
your Windows user ID and password to the server when a
connection is made.

Explicit: Passes the user ID and password you provide.

Password Passthru. The user ID and password received from
the client application are passed to your data source at
connection time. This option requires that the server be started
with security off.

Trusted: For a trusted connection, where the current logged on
user ID is passed to the server.

If the server is not on Windows and runs with security ON, providing
an explicit user ID and password is required to create synonyms.

SECURITY

If security is set to Explicit, enter a specific user ID.user

If you entered a user, provide a password.password

For a server on Windows, you can specify the domain where the
user ID is defined.

domain

Optionally, type a description for the node. This description displays
in the WebFOCUS front-end tools.

DESCRIPTION
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4. When connecting to a Unified Server, click the Advanced tab and specify the SERVICE
NAME, and other parameters, as required.

DescriptionAdvanced
Parameters

CLIENT (servicename)SERVICE NAME

Defines how to send outbound communications to a remote
server.

servicename is optional. If servicename is provided, it must
match the value of SERVICE in the service block of the server.

Defines whether the Secure Sockets Layer protocol is used in
the Web Console listener of the remote server. Enter:

HTTP_SSL

0 if no SSL is used in the connection to the WebConsole.

1 if SSL is used in the connection to the Web Console.

Activates data compression in a data transfer between client
and server. Enter:

COMPRES-SION

0 for no compression.

1 for compression on.

Defines the encr. Enter:ENCRYPTION

0 for no encryption.

DES for 56-bit fixed-key Data Encryption Standard.

Advanced, enables you to more easily select and combine
ciphers, modes, and RSA key lengths. This option provides
the following ciphers: 3DES, AES 128, AES192, AES 256;
and the following modes: ECB and CBC.

IBCRYPT for user-defined algorithm. Key is 512-bit RSA-
encrypted.

Note: Encryption is not supported for PIPE protocol. Only 0 and
DES are supported for HTTP protocol.
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DescriptionAdvanced
Parameters

Defines the maximum time, in seconds, that the client will wait
for a TCP connection response from the server. Enter:

-1 for indefinite wait.

0 for no wait.

CONNECT_LIMIT

Defines the time, in seconds, that the client will wait for a
response from the server:

-1 indicates indefinite timeout.

MAXWAIT

5. Click Save when you have provided your parameters values.

A message indicates that a new server was added.

6. Click Continue.

7. Expand Configured and Remote Servers to see the new server.
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8. Select the new server.

The Create Synonym, Test, Delete, and Properties buttons appear.

9. Click Test to test the connection.

If the remote server is started and you typed the correct connection parameters, sample
data should appear.

10. Click Close.

If the test fails, click the server, choose Properties, and provide an explicit user ID and
password. Then click Save and try the test again.

11. Click Close.

Your next step depends on your objectives and your server configuration:

If you wish to make the new remote server visible in and accessible from the Data Servers
folder as a distinct named entity, your next step is adding the remote server to your
WebFOCUS Client configuration. The listing of servers in this location is controlled by the
WebFOCUS client and implemented through the WebFOCUS Administration Console.
Proceed toDefining a Remote Server in the WebFOCUS Client Communication File on page
43.

If your objective is to access data on the remote server through your default server, you
must determine if the appropriate adapter and required synonyms already exist on the
remote server. If not, you must configure and create them. Proceed to Configuring Adapters
in Developer Studio on page 26 and then Creating Synonyms in Developer Studio on page
33.
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Creating Synonyms in Developer Studio

In this section:

Using the Reporting Server Web Console for Data Access and Synonym Preparation

How to:

Create a Synonym in Developer Studio

Refresh Synonyms

Delete Synonyms

Example:

Synonym Creation Parameters for Microsoft SQL Server

The point at which you begin to create synonyms will depend on your Adapter, Reporting
Server, and, possibly, also your WebFOCUS CIient configuration (as described in Data Access
Configuration Variations on page 19). Whenever you are ready, you can use the Create
Synonym tool to create synonyms for the data sources you need to access.

How to Create a Synonym in Developer StudioProcedure:

If it is not already open, to launch the Create Synonym tool from the WebFOCUS Environments
area of the Explorer:

1. Expand your WebFOCUS environment (for example, FLATIRON (UNIX Dev. WF Reporting
Server), expand Data Servers, expand the server, expand the Applications folder, expand
an application, and right-click the Master Files folder for the application in which you
wish to access the data source.

If you wish to use the data source in multiple applications, or have not yet created your
application, you can use the baseapp application, where resources can be stored for
sharing and access by other applications.

Tip: If you are developing from the Projects area of the Explorer, expand the project, and
right-click the Master Files folder, then proceed as described.

2. Select New and then Synonym. The Create Synonym tool opens.
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3. In the first window, you can choose any configured Data Adapter or any Remote Server
that has been added to the default Reporting Server. (Note that when you are creating
a synonym through a Remote Server, the remote server should already contain the
required synonyms and the corresponding adapters.)

The server configuration, indicated by the server profile, determines which adapters and
servers appear. In this example, the Adapter for Microsoft SQL Server is configured. If
you have configure remote servers, they will appear in expanded the Remote Server
folder.

4. Expand the folder for your adapter or the Remote Server folder.

5. Select the server or adapter that you configured and click OK.

A window opens in which you can enter additional information about the data source
you wish to access.

Important: The options in this window vary depending on the type of adapter or server
you are using. To access the pertinent information for your adapter directly from Developer
Studio, choose WebFOCUS Reporting Server Console from the Command menu. The
Server Console opens. Click Help on the menu bar, select Contents and Search, expand
the Adapters topic in the Table of Contents pane, and look for the adapter for which you
wish to create the synonym. The relevant synonym creation parameters are fully defined.
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The following example is for accessing an adapter for Microsoft SQL Server. For an
explanation of each synonym creation parameter or this adapter, see Synonym Creation
Parameters for Microsoft SQL Server on page 38.

After you complete this window, the data source or server is queried to determine the
metadata you can use to create synonyms. For a relational database, this is normally
a list of tables or views. This window lets you filter the results so there are fewer tables
from which to choose.

For some data sources, you have the option to choose a database or other parameter.

6. In this Microsoft SQL Server example, select the appropriate database or choose Use
current database. You will be able to choose from the database tables when this window
is complete.

7. Optionally, choose whether both Tables and Views should be returned. By default, both
are checked.

8. Optionally, check Filter by name and owner to filter the results based on owners or table
prefixes. This limits the list of tables returned from the remote data source and makes
it easier to choose the data for which you want to create synonyms. If you do not include
selection criteria, the entire list of tables is displayed.

9. Click Next.

Describing Data with Graphical Tools 35

2. Accessing Data and Creating Synonyms



The top of the Create Synonym window now displays additional fields you can use to
refine your synonym. Remember that the parameters vary depending on the type of
adapter or server you are using.

The bottom provides a list of tables for which you can create synonyms. To choose all,
select the check box to the left of Default synonym name.
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10. Click Create synonym.

The synonym is created and a confirmation window appears. Once again, note that the
window may vary depending on the type of adapter or server you are using.

The synonyms are created in the selected application directory. (In this example, the
default application, baseapp, is used.)

11. Click Close.
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Synonym Creation Parameters for Microsoft SQL ServerExample:

The following table describes the synonym creations parameters for Microsoft SQL Server.

DescriptionParameter/Task

An OS/400, collection is a special form of library that contains
Tables, Views, and Stored Procedures, as well as DB2 journals
and collectors that run automatically. Journals and collectors
enable the SQL commit/rollback work.

DB2 allows libraries without journals and collectors, however
this usage causes system log errors that report failed
journalizing, depending on ISOLATION level. For non-update
applications, use of a library that is not journalized is not a
problem since there is nothing to roll back.

When using the collection parameter, the Filter by Name and
Owner option behaves differently. For details, see Filtering by
Name and Owner (OS/400).

Collection (OS/400 only)

To specify a database from which you can select a table or
other object, do one of the following:

Check Use current database to use the database that has
been set as the default database.

Select a database from the Select database drop-down
list, which lists all databases in the current DBMS
instance.

Before selecting a database, if Use current database is
checked, uncheck it. (This does not apply to Informix SE,
for which Use current database must be checked.)

Database selection

Restrict candidates for synonym creation based on the
selected object type(s): Tables, Views, and any other
supported objects, such as Aliases, MQTs, Cubes, Nicknames,
Stored Procedures, Synonyms, and Materialized Views.

Nicknames is available as a filtering option on platforms where
DB2 supports the Nickname object type (Windows and UNIX).
A basic synonym is created for this type of DB2 object; no
Titles, Remarks, or Keys are recorded in the synonym. The
user ID who creates the synonym must have SELECT authority
for this object type.

Restrict Object Type to
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DescriptionParameter/Task

Selecting this option adds the Owner and Table Name (or
Object name) parameters to the screen:

Owner. Type a string for filtering the owner IDs, inserting
the wildcard character (%) as needed at the beginning
and/or end of the string. For example, enter: ABC% to
select tables or views whose owner IDs begin with the
letters ABC; %ABC to select tables or views whose owner
IDs end with the letters ABC; %ABC% to select tables or
views whose owner IDs contain the letters ABC at the
beginning, middle, or end.

Table Name (or Object name). Type a string for filtering
the table, view, or object names, inserting the wildcard
character (%) as needed at the beginning and/or end of
the string. For example, enter: ABC% to select all tables,
views, or objects whose names begin with the letters ABC;
%ABC to select all whose names end with the letters ABC;
%ABC% to select all whose names contain the letters ABC
at the beginning, middle, or end.

Filter by Name and Owner

Select the Cardinality check box to reflect the current
cardinality (number of rows or tuples) in the table during
metadata creation. Cardinality is used for equi-joins. The order
of retrieval is based on the size (cardinality) of the table.
Smaller tables are read first.

If the cardinality of the tables to be used in the application
are dynamic, it may not be beneficial to choose this setting.

Cardinality

Select the With foreign key check box to include within this
synonym every table related to the current table by a foreign
key. The resulting multi-table synonym describes all of this
table's foreign key relationships.

With foreign key

To specify that the Master File created for the synonym should
not contain column information, select the Dynamic columns
check box.

If this option is selected, column data is retrieved dynamically
from the data source at the time of the request.

Dynamic columns

Select an application directory. baseapp is the default value.Select Application
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DescriptionParameter/Task

If you have tables with identical table names, assign a prefix
or a suffix to distinguish them. For example, if you have
identically named human resources and payroll tables, assign
the prefix HR to distinguish the synonyms for the human
resources tables. Note that the resulting synonym name
cannot exceed 64 characters.

If all tables and views have unique names, leave prefix and
suffix fields blank.

Prefix/Suffix

To change the data type mappings from their default settings,
select this check box. The customizable mappings are
displayed.

Customize data type
mappings

To specify that this synonym should overwrite any earlier
synonym with the same fully qualified name, select the
Overwrite existing synonyms check box.

Overwrite Existing
Synonyms

This column displays the name that will be assigned to each
synonym. To assign a different name, replace the displayed
value.

Default Synonym Name

Select tables for which you wish to create synonyms:

To select all tables in the list, select the check box to the
left of the Default Synonym Name column heading.

To select specific tables, select the corresponding check
boxes.

Select tables

How to Refresh SynonymsProcedure:

Refreshing a synonym enables you to update field information while preserving the original
synonym title, description, usage, virtual field, and DBA information. The action also
synchronizes the Master File with the table on which the synonym is based.

You can refresh synonyms from either the Data Servers area under the WebFOCUS
Environments folder or from the Projects area.
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1. Right-click a synonym (Master File).

In the WebFOCUS Environments folder, Master Files are listed within an application
in the Data Servers, Applications area.

In the Projects area, Master Files are listed in a Master Files folder under a project
name.

2. Choose Refresh Synonym to recreate the Master File.

Note: Refresh is not applicable to cubes at the current time, and not supported for FOCUS
files.

How to Delete SynonymsProcedure:

Master Files and Access Files are removed from the server when you delete a synonym.

1. Right-click the synonym you want to delete and select Delete.

You are asked to confirm the deletion.

2. Click Yes to delete or No to cancel.

Using the Reporting Server Web Console for Data Access and Synonym
Preparation

How to:

Access the Reporting Server Web Console

A server administrator, or an application administrator who has been granted these privileges,
can configure and manage WebFOCUS Reporting Servers through the Reporting Server Web
Console. You can use the Server Console as an alternative to the Developer Studio tools to
configure adapters, add remote servers, and create synonyms. In addition, many other
configuration options are available through the Server Console. For a full understanding of
configuration options and server capabilities, see the Server Console help system or the
following manuals: Server Administration for UNIX, Windows, OpenVMS, i5/OS, and z/OS and
Adapter Administration for UNIX, Windows, OpenVMS, i5/OS, and z/OS.

Note:

This console is sometimes referred to as the Web Console or the Reporting Server
Console.

For Developer Studio installations that allow standalone development, the local, default
WebFOCUS Reporting Server normally runs with security OFF, and the user who installed
Developer Studio is the default administrator.
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How to Access the Reporting Server Web ConsoleProcedure:

1. Open the Reporting Server Web Console from Developer Studio by selecting its icon
from the Object Explorer toolbar or by going to the following page in a Web browser:

http://hostname:port#/webconsole

The Server Console opens in your Web browser.

2. To add an adapter through the Server Console, click Data Adapters on the menu bar.
On the expanded menu bar, click New Adapter, expand folders on the right, and click
your adapter type to bring up a form for adding the data adapter.

3. To create a synonym through the Server Console, click Metadata on the menu bar. On
the expanded menu bar, click New Synonym, select the remote server or adapter on the
right, and complete the forms that follow.

4. To access the Server Console help, click Help on the menu bar and choose Contents
and Search. Expand the Adapters folder in the Table of Content, and review the
information for your adapter.

Note: You may need to use Internet Explorer to properly view the help.
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Defining a Remote Server in the WebFOCUS Client Communication
File

How to:

Open the WebFOCUS Administrative Console From Developer Studio

Add a Remote Server to the WebFOCUS Environment

Change a Remote Server Node

If you have configured a WebFOCUS Reporting Server elsewhere in your enterprise to access
your data, and you wish to make that remote server visible in and accessible from the
WebFOCUS Environments, Data Servers folder as a distinct, named entity, you must add the
remote server to your WebFOCUS Client configuration. Except for the default server (e.g.,
EDASERVE), which is visible under Data Servers, the listing of servers in this location is
controlled by the WebFOCUS Client and implemented through the WebFOCUS Administration
Console, which updates the WebFOCUS Client's communication file (odin.cfg).

Once you add the Remote Server to your WebFOCUS Environment, you can access data and
perform development directly against the named remote server. That is, you can use a variety
of Developer Studio tools to access your application files, in their respective virtual folders,
for development purposes. For example, you can open synonyms in the Synonym Editor,
procedures in the Report Painter, and html files in the Report Layout Painter, and edit those
files as if you were working on your local machine. These Reporting Servers can also be
used by Managing Reporting if that environment is deployed in your organization.

How to Open the WebFOCUS Administrative Console From Developer StudioProcedure:

1. Select the WebFOCUS Environment you are working with.

2. Click the WebFOCUS Administration Console  icon on the Object Explorer toolbar.

3. When the Administration Console opens, log in to WebFOCUS.

Proceed as described in How to Add a Remote Server to the WebFOCUS Environment on page
43.

How to Add a Remote Server to the WebFOCUS EnvironmentProcedure:

1. Click Reporting Servers and then Remote Services.

2. Click New.
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3. In the NODE field, specify the name by which you will refer to the server. The name is
your choice, but cannot be the same as any other node name. In addition, the name
must begin with a letter and cannot be more than eight characters. When the WebFOCUS
Client accesses this server, it will use this name.

4. Specify the Node class (Client or Cluster).

If you specify Client, this node will function as a stand alone server. It can also be used
as an alternate server within a cluster configuration.

If you specify Cluster, this is the primary node that will be used to distribute workload
to alternate servers.

5. Click Next.

If you selected Client in step 4, proceed to step 6.

If you selected Cluster in step 4, proceed to step 7.

6. The New Node window opens. Enter the following required parameters:

a. HOST. Host name or IP address of the server.

b. PORT. Port number for the TCP listener. The default port is 8120.

c. HTTP_PORT. Port number for the HTTP listener. This is normally the second
consecutive port that the server uses. Type the same port number that was specified
during installation. The default HTTP port is 8121.

d. CLASS. If this is a z/OS server, you must include a qualifier.
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e. SECURITY.Determines how WebFOCUS connects to the WebFOCUS Reporting Server.
Possible values are as follows:

Default.Is the initial value for new nodes and represents the traditional behavior,
where the odin.cfg file does not contain a SECURITY keyword. In this case,
WebFOCUS makes an explicit connection to the Reporting Server with whatever user
ID and password it has available for the request. A user Id may come from
IBI_REPORT_USER on the console’s Client Settings, Reporting Server pane, from a
WebFOCUS Client Node Profile, or from the user’s WF_COOKIE if a Reporting Server
sign-on has taken place. How the server processes explicit connections depends
on its security setting (OFF, PTH, OPSYS, LDAP, DBMS).

HTTP Basic.Configures WebFOCUS to extract the user’s ID and password from the
Authorization header. These credentials are then used to make an explicit connection
to the WebFOCUS Reporting Server. You should only select this option when your
Web-tier is performing Basic Authentication so that the user’s Base64 encoded Id
and password will be available in the request header. For example:
Authorization Basic amx0XHdmdXNlcjp3ZnVzZXIx
To verify that the Authorization header is available to WebFOCUS, click the WebFOCUS
Administrative Console’s Diagnostics menu and select HTTP Request Info.

Kerberos.Configures WebFOCUS to pass the user’s Kerberos ticket to the
WebFOCUS Reporting Server. This option enables an end-to-end single sign-on
solution from the desktop to WebFOCUS to the Reporting Server, to supported
relational DBMS systems. When using this option, the WebFOCUS Reporting Server
must run in security OPSYS mode. There are additional setup requirements for
WebFOCUS and for Microsoft Active Directory, which are described in Technical
Memo TM4647.

SAP Ticket.Enables customers using WebFOCUS Open Portal Services in SAP
Enterprise Portal to achieve single sign-on through WebFOCUS to a Reporting Server
configured with the SAP Data Adapter. WebFOCUS passes along the user’s
MYSAPSSO cookie, created on SAP Enterprise Portal, to the Reporting Server which
validates it using the SAP security API.

Service Account.Enables you to specify a user ID and password to be used for all
connections to the Reporting Server. The credentials are encrypted and stored in
the odin.cfg file’s SECURITY keyword. When defined, the service account overrides
any other credentials that might be presented to WebFOCUS for this Reporting Server
node.
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Trusted.Enables you to connect to the Reporting Server with only a user Id. This
option is useful when no password is available for the user, and controls can be
placed on the server to ensure that connections from unauthorized clients are
rejected (for example, employing the server’s RESTRICT_TO_IP setting so that only
a particular WebFOCUS client can connect to the server).

If the server runs in security OPSYS mode, the connecting user ID must be valid on
the server’s operating system and the Reporting Server cannot run on Windows. In
this scenario, the connecting user appears in the server’s edaprint.log and is returned
by the server’s GETUSER and CNCTUSR subroutines. The report agent runs in the
security context of the connecting user, which makes it possible to use operating
system permissions and the trusted option for DBMS adapters in order to restrict
file and data access.

Trusted connections are also supported by servers running in security OFF, PTH,
and LDAP modes provided that the server's trust_ext setting is enabled.

In this configuration the connecting user appears in the server's edaprint.log and
is returned by the server's CNCTUSR subroutine. The server's GETUSER subroutine
will always return the user ID that started the server. When the server runs in LDAP
mode the connecting user must be found in the LDAP directory before the connection
is accepted.

If the server runs in the PTH or OFF security modes, then trusted connections will
be accepted without authentication by Reporting Servers on any platform, including
Windows. The server’s edaprint.log and CNCTUSR subroutine will reflect the
connecting user ID, and the server’s GETUSER subroutine shows the user ID that
started the server.
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The following lines in a report request are useful to determine connection behavior:

-SET &CONNECT_USER = CNCTUSR('A30');
-SET &AGENT_USER = GETUSER('A30'); 
-TYPE Connect User is: &CONNECT_USER
-TYPE Report Agent runs as: &AGENT_USER

When you select Trusted, the following addtional settings are displayed:

Select which option will be used to retrieve the connected user.

Note: Trusted connections are not supported by servers running in security DBMS
mode.

Note: You can also specify the following optional parameters:

f. COMPRESSION. Turns on data compression. Codes are: 0 (off) and 1 (on).

g. ENCRYPTION. Sets data encryption ability and cryptography symmetric method
used.

Select one of the following options from the drop-down list:

0 = off

DES =168-bit

3DES = 512-bit

3DESx = 1024-bit

IBCRYPT = user defined IBCRYPT DLL is loaded

Note: Triple DES and IBCRYPT are not supported under the HTTP protocol or for
communication to and from the MVS server. In addition, if encryption is set manually
outside of the console using the odin.cfg file, the console displays it as a static
value and it cannot be modified using the console.

h. CONNECT_LIMIT. Number of seconds the client holds the pending connection. This
is useful in a cluster deployment to avoid a lengthy delay of failover response. Other
possible values are 0 (no wait) and -1 (infinite wait). -1 is the default value.

i. MAXWAIT. <query wait>[,<row wait>]. Time the client waits before timeout. The
first number is the return time for any row. The second number (optional) is the
return time for rows beyond the first row. Time is in seconds.
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j. DESCRIPTION. Description for the WebFOCUS Reporting Server node. This
description displays in the WebFOCUS front-end tools.

Proceed to Step 8.

7. The New Cluster Node window opens. Enter the following required parameters:

a. ALTERNATE. Select the servers to be included in the cluster.

b. DESCRIPTION. Description for the cluster.

TIp: More advanced cluster functionality can be configured using the iWay Client
Web Console. For details, see see Technical Memo 4641: Distributing Workload
Across Clustered WebFOCUS Reporting Servers. Changed cross-ref, moved info as
agreed

8. Click Save.

How to Change a Remote Server NodeProcedure:

1. Click Reporting Servers and then Remote Services.

2. Select the node you want to change.

3. Click one of the following buttons:

Modify. Displays the settings for the selected node, enabling you to make changes.

You can select the Set as Default Server Node check box to specify that the node is
the default WebFOCUS Reporting Server. The node will be written as the
IBI_REPORT_SERVER parameter value in the cgivars.wfs file. Note that even if you
check Set as Default Server Node, this can be overridden if an IBIC_server is set in
site.wfs or a node profile.

If the site.wfs file or request URL contains an IBIC_server setting, it will override the
IBI_REPORT_SERVER parameter. In this case, the WebFOCUS Administration Console
indicates that the IBI_REPORT_SERVER is the default node, even though it is no
longer the default.

You can also click Save As to save these settings for another specified node that
will be added to the ibi\WebFOCUS76\client\wfc\etc\odin.cfg file.

Remove. Deletes the selected node. You will receive a message asking for you to
confirm the deletion. This button only appears if you have more than one node defined.

Profile. Enables you to override WebFOCUS default settings for a specific WebFOCUS
Reporting Server node. These settings are written to
ibi\WebFOCUS76\client\wfc\etc\node.prf, where node is the node you selected in
Step 2.
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Server Console. Displays the WebFOCUS Reporting Server Console, which enables
you to remotely manage your server environment. For more information, see the iWay
Server Administration for UNIX, Windows, OpenVMS, i5/OS, and z/OS manual.

Note: You can select the Sort alphabetically check box to sort a list of multiple servers.
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WebFOCUS7

Using the Synonym Editor3
This chapter describes the Synonym Editor and how you may use it to view and edit synonyms in Developer
Studio.

Using the Synonym Editor for Cube Data
Sources

Topics:

Using the Synonym Editor

Synonym Editor Layout
Creating Business Views in Developer Studio

Adding Virtual Columns (DEFINE) in a Synonym
Viewing and Editing Synonym Attributes

Creating Filters in a Synonym
Setting Up Multilingual Titles and Descriptions

Adding Computed Fields (COMPUTE) in a
SynonymEnhancing Synonyms Using the Modeling View

Creating Cluster Joins Defining Attributes and Creating Expressions
for Custom FieldsDefining Dimensions for OLAP Analysis

Adding Group Fields in a Synonym

Applying Database Administrator Security
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Using the Synonym Editor
The following image is an example of how to access the Synonym Editor from Developer
Studio.

A synonym consists of a set of attributes that describe the data source. It provides the
metadata for a data source, which enables an adapter to access and interpret the
corresponding data.

52 WebFOCUS7

Using the Synonym Editor



Synonym Editor Layout

Reference:

Synonym Editor - Tree View Tab

Synonym Editor - Segment Pop-up Menu

Synonym Editor - Column/Field Pop-up Menu

Synonym Editor - Modeling View Tab

Synonym Editor - Synonym Text View Tab

Synonym Editor - Access File Text View Tab

Synonym Editor Toolbar

The Synonym Editor occupies the Developer Studio workspace and displays Tree View,
Modeling View, Synonym Text View, and Access File Text View tabs.

Synonym Editor - Tree View TabReference:

The Tree View tab shows a hierarchy of segments and columns on the left, with the attributes
and values of the selected item on the right.

Note: The attributes available depend on the type of synonym.
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The image below is an example of a Microsoft SQL Server data source with a key column
selected.

Note: Information about the attribute that has focus is displayed at the bottom of the
attribute list. In this case, an explanation of the FIELDNAME attribute appears.

The following objects may appear on the Tree View tab.

FunctionObject

Synonym.

General icon used to indicate synonyms, visible on top of the Tree View tab.
It provides information about the file name used and the application it
resides in.

Segment.

Indicates a segment in a synonym. The root or parent segment appears
first in the tree.

Unique Segment (FOCUS/FDS and XFOCUS only).

Indicates a unique segment in a FOCUS/FDS or XFOCUS synonym.
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FunctionObject

Virtual Segment (Cross-Referenced).

Indicates a virtual or cross-referenced segment.

Note: This type of segment is applicable for FOCUS data sources.

Key Column.

Indicates a key column.

Column.

Indicates a general column.

Virtual Column (Define).

Indicates a virtual or defined column. For more information about virtual
columns.

See Adding Virtual Columns (DEFINE) in a Synonym on page 120.

Index Column.

Indicates an index column.

Filter.

Indicates a Master File filter.

Compute field.

Indicates a computed field.
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Synonym Editor - Segment Pop-up MenuReference:

When you right-click a segment in the Synonym Editor, the following pop-up menu appears
in the Tree View tab.

The image below is an example of a MS SQL Server data source with the root segment
selected.
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The following options are available:

Add

Enables you to add one of the following:

Segment From Existing Synonym

Adds an existing synonym to the current synonym.

Segment Via Metadata Import

Enables you to create and add a new synonym to the current synonym through the
Create Synonym tool.

Segment Manually

Adds a synonym that must by coded manually.

Column

Adds a column to the segment.

Virtual Column

Adds a virtual column to the segment.

Filter

Adds a filter to the segment.

Compute

Adds a calculated value to the file.

Group

Adds a group column to the segment.
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Data Profiling

Provides the characteristics of the data for a segment.

Data Profiling is available from the right-click context menu for all columns in the Master
File hierarchy tree.

Sample Data

Displays sample data in the workspace.

Sample data is available from the Synonym Editor toolbar, the right-click context menu
for all columns in the Master File hierarchy tree, and from the Modeling View.

The following image is an example of the sample data that appears for a segment:

Note: Sample Data is a great way to test the synonym for field data and to view the type
of records returned. This can assist when performing Joins, testing connectivity to data
sources, and so on.

Delete

Deletes the segment.

Rename

Enables you to rename the segment.
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Synonym Editor - Column/Field Pop-up MenuReference:

When you right-click a column in the Synonym Editor, the following pop-up menu appears in
the Tree View tab.

The image below is an example of a MS SQL Server data source with a column selected.
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The following options are available:

Add

Enables you to add one of the following:

Column

Adds a column to the synonym.

Virtual Column

Adds a virtual column to the synonym.

Filter

Adds a filter to the segment.

Compute

Adds a calculated value to the file.

Group

Adds a group column to the synonym.

Impact Analysis

Displays an Impact Analysis report for the particular column in the workspace.

Data Profiling

Provides the characteristics of the data for a column. Data Profiling is available from the
right-click context menu for all columns in the Master File hierarchy tree.

Sample Data

Displays sample data in the workspace.

Sample data is available from the Synonym Editor toolbar, the right-click context menu
for all columns in the Master File hierarchy tree, and from the Modeling View.
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The following image is an example of the sample data that appears for a column:

Note: Sample Data is a great way to test the synonym for field data and to view the type
of records returned. This can assist when performing Joins, testing connectivity to data
sources, and so on.

Decompose Date

Decomposes date fields into virtual columns representing Year, Month, Day, and Quarter
fields.

Note: Decompose date is visible for date fields.

Delete

Deletes the column.

Rename

Allows you to rename the column.
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Synonym Editor - Modeling View TabReference:

The Modeling View tab shows a graphical representation of the synonym. Use the Modeling
View to define dimensions for OLAP analysis, view join properties, create cluster joins, and
add or edit segments.

The image below is an example of a MS SQL Server data source in the Modeling View.

For more information about the Modeling View, see Enhancing Synonyms Using the Modeling
View on page 79.
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Synonym Editor - Synonym Text View TabReference:

The Synonym Text View tab shows the description of the underlying table.

Note: You can print the Master File code by selecting Print from the File menu.

The image below is an example of a MS SQL Server data source in the Synonym Text View
tab.

Note: The text views are read-only. You cannot edit the underlying description from these
tabs. To edit a synonym using an editor in Developer Studio, you can select Edit in Text Editor
from the Projects or Data Servers area context menu.
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Synonym Editor - Access File Text View TabReference:

The Access File Text View tab shows the description of a synonym's Access File, which is
used to access the database.

Note: You can print the Master File code by selecting Print from the File menu.

The image below is an example of a MS SQL Server data source in the Access File Text View
tab.

Note: The text views are read-only. You cannot edit the underlying description from these
tabs.

Synonym Editor ToolbarReference:

The Synonym Editor toolbar contains buttons that provide quick access to commonly
performed functions. The behavior of the button is determined by the selected object.
Therefore, certain toolbar buttons may be inactive.

DefinitionButton

Saves the edits made to the synonym.

Enables you to add segments from an existing synonym by using the Select
Synonym dialog box.

Enables you to add segments via metadata import by using the Create
Synonym tool. This tool creates a synonym and includes it as a segment in
the synonym from which the tool was launched.
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DefinitionButton

Enables you to add segments manually, assigning values to segment attribute
fields in the Synonym Editor.

Note: You would only use this approach if you are coding a Master File from
scratch, as you would for a FOCUS data source.

Adds a column field.

Adds a virtual column (DEFINE) field.

For more information about virtual columns, see Adding Virtual Columns
(DEFINE) in a Synonym on page 120.

Adds a Master File filter.

For more information about filters, see Creating Filters in a Synonym on page
124.

Adds a COMPUTE field.

For more information about computed fields, see Adding Computed Fields
(COMPUTE) in a Synonym on page 128.

Adds a group.

For more information about groups, see Adding Group Fields in a Synonym
on page 140.

Deletes the selected item.

Adds field/value security DBA.

For more information about DBA security, see Applying Database Administrator
Security on page 146.

Enables you to view and refresh sample data for the object.

Enables you to create a business view and create a custom Master File that
can use selected fields from the original synonym. In addition, you may
customize field names, titles, and descriptions.

For more information about business views, see Creating Business Views in
Developer Studio  on page 111.
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Viewing and Editing Synonym Attributes

How to:

View and Edit Synonym Attributes

Reference:

File Attributes Summary

Segment Attributes Summary

Column/Field Attribute Summary

The Synonym Editor enables you to view and edit a synonym's attributes.

How to View and Edit Synonym AttributesProcedure:

To view and edit synonym attributes:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens to the Tree View tab, which shows a hierarchy of segments
and columns on the left, with the attributes and values of the selected item on the right.

Note: The attributes available depend on the type of synonym.
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The image below is an example of a Microsoft SQL Server data source with a key column
selected.

Note: The Format, Expression, Description, and Nulls values are viewable in the hierarchy
with the columns. To edit these values, use the corresponding attribute fields on the
right-hand side of the Synonym Editor.

2. You can change the attribute values by typing in new values or by using the drop-down
menus and check boxes.

Note: The Synonym Editor does not let you make any changes that would render the
Master File unusable. Therefore, you cannot edit any value field that is highlighted gray.
In addition, if a change does not have proper syntax/format applied, the field may appear
in red text. Messages and warnings appear if trying to save a file with an error.

3. Save changes by clicking Save from the File menu.

4. To close the Synonym Editor, select Close from the File menu or click the control button
in the upper right corner.

Note: If you close the Synonym Editor without saving your changes, you are prompted to do
so.
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File Attributes SummaryReference:

The image below is an example of a MS SQL Server data source with the synonym file name
selected.

Note: Information about the attribute that has focus is displayed at the bottom of the
attribute list. In this case, an explanation of the SUFFUX attribute appears.
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Synonyms can have the following file attributes:

General

SUFFIX

Identifies the type of synonym or data source.

FDEFCENT

Defines the default century value, specifying a century number for handling cross-
century dates.

Note: Use the default setting (0) unless you wish to retrieve data from a earlier
century. For example, 19xx.

FYRTHRESH

Defines the base years—to represent the lowest year to which the century value
applies (FDEFCENT).

Note: Use the default setting (0) unless you wish to retrieve data from a earlier
century. For example, 19xx.

REMARKS

Enables you to include descriptive information at the file level and specify multiple
language descriptions for the synonym. Remarks are displayed along with the file
name during reporting.

For more information about multilingual descriptions, see Setting Up Multilingual
Titles and Descriptions on page 77.

DATASET

Identifies the physical location of the data source to be used in the file name,
including the extension and the location of the data file.

Note: The attributes available depend on the type of synonym.
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Segment Attributes SummaryReference:

The image below is an example of a MS SQL Server data source with a segment selected.

Note: Information about the attribute that has focus is displayed at the bottom of the
attribute list. In this case, an explanation of the SEGMENT attribute appears.
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Segments in a synonym can have the following attributes:

General

SEGMENT

Is the name of the segment.

ENCRYPT

Check this box to scramble field values in the current segment in order to protect it
from unauthorized examination.

Note: You must assign a DBA password to the file before setting the Encrypt option
on. For details, see Encrypting and Decrypting a Master File on page 151. You must
then turn the Encrypt option on before adding any records. If you add a record to a
segment before setting the Encrypt option on, that value will not be encrypted.

Once a segment is encrypted, you can remove encryption only if you remove the
segment and recreate it without turning on the Encrypt option.

Tip: Because there is a loss of processing efficiency when data is encrypted,
encryption should be used selectively.

SEGTYPE

Specifies the type or relationship that a segment has to its parent and indicates
which of the segment’s fields are key fields, and in what order they are sorted.

Type - Identify the segment type and sorting options from the Type drop-down list.

Keys - Records are sorted in a data source by key fields. Enter the number of key
fields that you want to use for sorting. For example, no two employees can have the
same employee ID number, so you can use that field as the key. A segment instance
can have more than one field that makes up the key; that is, two or more field values
may be used to distinguish records.

SEGSUF

SEGSUF is used when part of the data source being described by the Master File is
of a different data source type than that declared for the entire structure.

Note: SEGSUF is the data source type of a segment and any descendants it might
have, where that type differs from the SUFFIX value.
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Miscellaneous

DESCRIPTION

Contains a description or comments about the segment.

For more information about multilingual descriptions, see Setting Up Multilingual
Titles and Descriptions on page 77.

CRFILENAME

Is the name of the cross-referenced data source.

CRSEGNAME

Is the name of the cross-referenced segment.

CRKEY

Identifies the common join field for the cross-referenced segment.

Note: These cross-referenced values (CRFilename, CRSegname, CRKey) are available
for FOCUS data sources.

Adapter Specific

Note: Adapter Specific fields are shown if an Access File component has been generated
with the synonym.

CONNECTION

Indicates the host server or data source for synonyms.

TABLENAME

Identifies the table or view. It may contain the owner ID, as well as the table name.
For some synonyms, it must also contain the data source name.

KEYS

Identifies how many columns constitute the primary key.
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KEYORDER

Identifies the logical sort sequence of data by the primary key.

WRITE

Specifies whether write operations are allowed against the table.

CARDINALITY

Defines the number of records that are found in the original data source when the
synonym was created.

DBSPACE

Identifies the storage area in which the table resides.

Note: The attributes available depend on the type of synonym.
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Column/Field Attribute SummaryReference:

The image below is an example of a MS SQL Server data source with a key column selected.
Note: The attributes available depend on the type of synonym.

Note: Information about the attribute that has focus is displayed at the bottom of the
attribute list. In this case, an explanation of the FIELDNAME attribute appears.

Columns in a synonym can have the following attributes:

General

FIELDNAME

Is the name of the column.

ALIAS

Assigns an alternative name for a column, or the real column name for a DBMS
synonym.
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MISSING

Controls how null data is handled, that is, if no transaction value is supplied.

TITLE

Supplies a title to replace the column name that is normally used in reports and
enables you to specify multiple language titles for the column or field.

For more information about multilingual titles, see Setting Up Multilingual Titles and
Descriptions on page 77.

USAGE

Describes the data type and format for the column for usage or display.

Note: Additional attributes, DEFCENT and YRTHRESH, are available if the Usage
field is set to Date, Time, or DateTime (Timestamp) format. Use these attributes to
enter the century and year threshold values for the column/field.

Miscellaneous

DESCRIPTION

Contains a description or comments about the column or field.

For more information about multilingual descriptions, see Setting Up Multilingual
Titles and Descriptions on page 77.

ACCEPT

Specifies criteria for validating data.

OR enables you to specify an acceptable value.

FROM-TO enables you to specify a range of acceptable value fields.

FIND enables you to supply file and field names to instruct WebFOCUS where to
search for a data source and for a list of acceptable values. You supply the field
name of the data field for which the validation criteria are being assigned, the file
name of the target FOCUS data source where the field can be found, and the field
name of the target data field that contains the validation criteria.

Note: Find is only available for FOCUS data sources and does not apply to OLAP-
enabled Master Files.  Note also that, in the Maintain environment, Find is not
supported when developing a Master File.
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WITHIN

Contains the name of a field to be included in a dimension.

These WITHIN statements are added to the synonym through the Dimension Builder
to OLAP enable FOCUS files and relational tables. This enables you to perform OLAP
analysis using the Developer Studio OLAP Control Panel, or to use it with the FML
Painter.

FIELDTYPE

Identifies an indexed column.

Note: FIELDTYPE=R indicates a read-only column, which will not be updated by DM
flows. This setting is useful for columns are that automatically assigned a value by
the RDBMS, such as a Sybase or MS SQL Server Identity or Timestamp column.

ACCESS_PROPERTY

Specifies access options for the column's data.

INTERNAL defines a column that does not appear in sample data or in the list of
available columns. Restricts the field from showing in any of the Field Lists in the
reporting tools.

NEED_VALUE defines a column that requires a value to access the data.

Select By defines a column by value, range, or multivalues.

AUTHRESP defines a column that describes the result of an authentication operation.
Correct response values must be provided in the ACCEPT attribute (using the OR
predicate if more than one value is acceptable).

AUTHTOKEN defines a column that contains a response token to be passed as an
input value to the operation to be executed.

HELPMESSAGE

Appends a help message to a column.

Note: The attributes available depend on the type of synonym.
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Setting Up Multilingual Titles and Descriptions

How to:

Set Up Multilingual Titles and Descriptions

You can open a synonym in the Synonym Editor and provide text for the title, caption, and
description in multiple languages. These descriptions appear in the specified language in
reports generated against the synonym.

The Multilingual Titles dialog box is available from the Remarks, Title, and Description
attribute value fields in the Synonym Editor.

Note: The attributes available depend on the type of synonym.

How to Set Up Multilingual Titles and DescriptionsProcedure:

1. From the Projects or Data Servers area in Developer Studio, double-click the Master File
or select Edit in Synonym Editor from the File menu.

The Master File opens to the Tree View tab in the Synonym Editor.

2. To add multilingual text:

For Title, click a column from the Master File hierarchy of columns on the left.

For Remarks, click the root level of the Master File (application/filename) on the
left.

For Descriptions, click a column, segment, or custom field from the Master File
hierarchy of fields on the left.

The corresponding attributes and values appear on the right.

3. Click the ellipsis (...) at the end of the value field for either Remarks, Title, or Description.

The Multilingual dialog box opens.
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4. From the Specify Titles/Descriptions for different languages drop down list, choose the
language in which you want the remarks (descriptions) and/or titles to be displayed.

5. Click Add.

The selected language is added below the default language (which is determined by
your code page selection).

6. Type in a description/title in the Text field.
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7. You may add, edit or delete additional titles/descriptions:

To add an additional language:

a. Select another language from the drop-down list.

b. Click Add.

c. Type in a title/description for the field.

To edit an existing specified title/description:

a. Select the title/description and click Edit.

You may also double-click the title.

b. Manually type a title/description name.

To delete a specified title:

a. Select the title/description and language to be deleted.

b. Click Delete.

8. Click OK to close the Multilingual Titles dialog box.

9. Click Save from the File menu to save the synonym.

10. To close the synonym, select Close from the File menu or click the control button in the
upper right corner.

Enhancing Synonyms Using the Modeling View

How to:

Enhance Synonyms Using the Modeling View

Edit Synonyms Using the Modeling View

Reference:

Modeling View Pop-up Menu

Join Properties Dialog Box

The Synonym Editor Modeling View tab provides a visual presentation for the synonym for
which positioning is preserved and stored in the Access file. Use the Modeling View to define
dimensions for OLAP analysis, view join properties, create cluster joins, and add or edit
segments. For more information about using the Dimension Builder in the Modeling View,
see Defining Dimensions for OLAP Analysis on page 96.

Note: The Modeling View is not available for Cube data sources.
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How to Enhance Synonyms Using the Modeling ViewProcedure:

Use the Modeling View to enhance a synonym by adding a segment.

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens.

2. Click the Modeling View tab.

The Synonym Editor Modeling View tab opens in the workspace.

3. Right-click a segment in the workspace.

The following pop-up menu appears.

4. Add segment through one of the methods listed:

Add Segment From existing synonym adds an existing synonym as a segment to the
current synonym.

Adding Segment Via metadata import enables you to add segments by using the
Create Synonym tool. This tool creates a synonym and includes it as a segment in
the synonym from which the tool was launched.

Add Segment Manually enables you to add segments manually to the current synonym.

Note: You would only use this approach if you are coding a Master File from scratch,
as you would for a FOCUS data source.
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5. Optionally, you can double-click the arrowed lines between tables to open the Join
Properties dialog box and determine how the tables are linked.

Tip: You may also right-click a file icon and select Join Properties from the context menu.

In addition, when creating a Cluster Join, there are two additional options for linking
tables: Join All (default) is shown by a double arrow and Join Unique is shown as a single
arrow.

Note: Join options are not available for FOCUS files.

How to Edit Synonyms Using the Modeling ViewProcedure:

To edit synonyms using Modeling View:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens.

2. Click the Modeling View tab.

3. Right-click a segment icon.
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A pop-up menu appears, providing options for adding segments.

Note: Options for adding segments are also available from the icons above the
workspace.
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To Add a Segment From an Existing Synonym:

a. Select Add Segment From Existing Synonym from the pop-up menu.

The Select Synonym dialog box opens.

b. Click a synonym and click Select.

The segment is added to the synonym.
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To Add a Segment Via Metadata import:

a. Select Add Segment Via metadata import from the pop-up menu.

This method enables you to launch the Create Synonym tool, create a synonym,
and incorporate it as a new segment in the synonym from which you initiate the
import.

The Create Synonym dialog box opens.

b. Create a synonym.

The segment is added to the synonym.

To Add a Segment Manually:

a. Select Add Segment Manually.

The segment is added to the Modeling View and a default field is created, using a
default name SEG name.
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b. Right-click the segment and select Properties.

The Segment Properties dialog box opens.

c. Edit the segment's properties, if needed, and click OK.

d. Switch to the tree view to add or change attributes for the new segment(s).
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The following image shows a synonym which has had several segments added in the Modeling
View tab.
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The following image shows the resulting Text View.

The following image shows the resulting Access File Text View.

Modeling View Pop-up MenuReference:

When you right-click a synonym or segment in the Synonym Editor Modeling View tab, the
following pop-up menu appears.
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The following pop-up menu appears.

The pop-up menu has the following options:

Toggle

Changes the view from a file icon to a table view, which enables you to see columns,
sample data, and sample data parent keys.

Tip: You may also double-click a file icon to open the table view. Double-click the table
to close the table view, or click the X button from the toggle toolbar to close.

Join Properties

Provides access to the Join Properties window.

Note: Join options are not available for FOCUS files.

Add Segment From Existing Synonym
Enables you to add an existing synonym as a segment to the current synonym.
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Add Segment Via metadata import

Enables you to create a new synonym through the Create Synonym tool and add it to
the current synonym.

Add Segment Manually

Adds a segment to the current synonym, that must by coded manually.

Delete

Deletes the segment.

Rename

Enables you to rename the segment.

Properties

Launches the Segment Properties dialog box where you can edit the segment.
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Join Properties Dialog BoxReference:

When you select Join Properties from a segment in the Synonym Editor Modeling View tab,
the Join Properties dialog box appears.

The Join Properties dialog box contains Left and Right Source Columns, Join Type, and Join
Condition options. Use the left and right source columns to create join maps and view sample
data.

Note: Join options are not available for FOCUS files.
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Creating Cluster Joins

How to:

Create a Cluster Join by Enhancing Existing Synonyms

Create a Cluster Join Using a New Synonym

Cluster Joins enable you to create a new file structure by linking existing synonyms of two
or more relational tables using the same or mixed data sources. For example, you may join
a MS SQL Server table with a MS Access table, or a DB2 table and an Oracle table, and so
on. Use Cluster Joins to create new views in the metadata by linking together physical tables
and easily report against the new view/structure. You can create cluster joins by using the
Modeling View of the Synonym Editor.

The Master File description that is created combines the fields of the joined tables within a
single file. The Access File from the combined file contains information about the actual
location of the data sources, the Join information, and shows how the tables are linked.

The total number of tables that you can add to the tool is 64 (using 63 joins) that results
in a new Master File that has a maximum of 64 segments.

How to Create a Cluster Join by Enhancing Existing SynonymsProcedure:

Use the Modeling View to enhance an existing synonym by adding a segment.

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens.

2. Click the Modeling View tab.

The Synonym Editor Modeling View tab opens in the workspace.

3. Right-click a segment in the workspace.
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The following pop-up menu appears.

4. Add tables (segments) through one of the methods listed:

a. Add Segment From Existing synonym.

Select a synonym to be added and click Select.

Note: Use this method if you are creating a cluster join with an existing
table/synonym.

Tip: Click Save As from the Modeling View File menu if you do want to modify the
original synonym.
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b. Adding Segment Via metadata import enables you to add segments by using the
Create Synonym tool. This tool creates a synonym and includes it as a segment in
the synonym from which the tool was launched.

Note: Use this method if you are creating a cluster join and need to use a synonym
that does not exist. This option enables you to create the synonym and continue to
create the cluster join.
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c. Add Segment Manually enables you to add segments manually, assigning values
to segment attribute fields in the Synonym Editor.

Note: Use this method if you are coding a Master File from scratch, as you would
for a FOCUS data source.

The segment is added in the Modeling View.

5. Right-click the arrowed lines between tables to view the join options.

Note: These join options are not available, and do not appear, for FOCUS tables. The
only way to view these options are by using Relational tables.
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Join All indicates a multiple instance (one-to-many) type of join. At run time, each
host record can have many matching records in the cross-referenced file.

Note: Join all is the default option.

Join Unique indicates a single instance (one-to-one) type of join. At run time, each
host record has, at most, one matching record in the cross-referenced file.

Join Properties opens the Join Properties dialog box, from which you can determine
how the tables are linked. You may:

Create Inner, Outer, or Cross Joins.

Note: Outer joins are subdivided into Left Outer Joins, Right Outer Joins, or Full
Outer Joins.

Combine records from the selected tables by mapping source columns.

Use the Tree and Text View tabs of the Synonym Editor to view or edit the details of
these tables (segments).

Tip: Click Save As from the Modeling View File menu if you do want to modify the original
synonym.
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How to Create a Cluster Join Using a New SynonymProcedure:

Another way to create a cluster join is to start with an empty synonym:

1. Right-click a Master Files folder, select New, then Synonym via Synonym Editor.

The Add Master File dialog box opens.

2. Enter a unique file name in the File name field.

3. Click Open.

The Synonym Editor opens to the Modeling View tab.

4. Right-click in the workspace and select from one of the available options to start building
the new view.

Defining Dimensions for OLAP Analysis

In this section:

Using the Dimension Builder in the Synonym Editor Modeling View

Synonyms can be modified to support Online Analytical Processing (OLAP). The Synonym
Editor provides tools to create OLAP hierarchies and dimensions. OLAP enables you to drill
down or roll up on hierarchical data, pivot fields from columns to rows (or vice versa), and
slice-and-dice information by filtering or querying data sources based on specified criteria
thresholds.

You OLAP-enable the Master File by using the Synonym Editor to create dimension(s) at the
field level and associate fields with each dimension.

Note: OLAP is a reporting facility; it is not relevant to data maintenance projects.
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Using the Dimension Builder in the Synonym Editor Modeling View

How to:

Add a Parent/Child Hierarchy

Delete a Dimension

Add Levels to the Hierarchy

Reference:

Dimension Builder Toolbar

The Dimension Builder enables you to create logical views based on enterprise data (relational
or legacy data sources) for multi-dimensional analysis without manually editing metadata.
The Dimension Builder works with relational and FOCUS data sources.

How to Add a Parent/Child HierarchyProcedure:

1. From the Synonym Editor, click the Modeling View tab.

The Dimension Builder appears on the right side of the window.

Note: If the Dimension Builder is not visible, ensure that Dimension Builder is selected
from the Synonym menu.
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2. Right-click the dimension and select Parent/Child from the Add Hierarchy submenu.

Note: You may also select this option by clicking the Add Parent/Child Hierarchy button
from the Dimension Builder toolbar.

The Mandatory Properties for Parent/Child Hierarchy dialog box appears.

3. Select a field from the Field Tree and click Assign to assign a Unique ID for the hierarchy.

4. Repeat Step 3 for the Caption and Parent hierarchy properties.
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5. Click OK to close the Mandatory Properties for Parent/Child Hierarchy dialog box.

The Mandatory Properties are added to the Dimension Builder.

6. Use the right-click menu to rename the dimension, view properties, or view sample data
for the dimension.

7. Click Save from the File menu to save the dimension.

How to Delete a DimensionProcedure:

To delete a dimension, right-click a dimension and select Delete, or click the Delete button
from the Dimension Builder toolbar.

How to Add Levels to the HierarchyProcedure:

This process enables you to edit an existing Master File, add tables (for non-FOCUS Master
Files), and create and modify dimensions.

1. From the Synonym Editor, click the Modeling View tab.

2. Select the Add Levels Hierarchy button from the Dimension Builder toolbar.

A level is added to the hierarchy. Use the right-click menu to rename the dimension or
keep the default name.
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3. Right-click the file icon in the Modeling View to toggle to the table view, which enables
you to see columns, sample data, and sample data parent keys.

The table view appears in the Modeling View.

Tip: You may also double-click a file icon to open the table view.

4. Using the Columns tab of the table view, drag and drop selected fields to the Dimension
Builder hierarchy folder.

You may also drag and drop fields to and from other hierarchies using the Dimension
Builder.

5. Click Save from the File menu to save the dimension.

The dimension is saved and store in the Master File.
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Dimension Builder ToolbarReference:

You can access the following commands from the Dimension Builder toolbar:

DefinitionButton

Adds a level hierarchy.

Enables you to create a parent/child hierarchy and assign mandatory
properties for the hierarchy.

Deletes the selected item.

Enables you to view and refresh sample data for the selected field.

Enables you to switch back to properties in the Tree View tab of the Synonym
Editor.

Using the Synonym Editor for Cube Data Sources

How to:

Edit Field Names and Titles

Edit Titles for Multiple Languages

Delete Measures, Dimensions, or Parent/Child Hierarchies

Create Virtual Measures With COMPUTES

Reference:

Cube View Tab Objects

The Synonym Editor enables you to make further modifications to your Cube synonym
definitions. The Cube synonym is displayed in the Cube View tab. If you select a component
of the synonym, its properties appear in the right pane.

You can use the Synonym Editor to:

Edit field names and titles for measures, properties, and variables. You may also edit
the field prefix for the defined fields.

Edit titles for multiple languages, delete titles, and add titles for additional languages if
you are using code page UTF8.
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Delete measures, dimensions, or parent/child hierarchies.

View the usage and actual formats and the ability to change the usage display format
for the field.

Change an internal attribute value.

Change the access property for variables.

Change the field prefix used to create the field names, mandatory property names, and
DEFINE field names generated for parent/child hierarchies by the Synonym Wizard.

Create virtual measures (this is implemented with COMPUTEs in the Master File).

The following image is an example of a Cube data source in the Synonym Editor.

Note: The Synonym Text View tab and the Access File View tab are identical for all types of
data sources. For more information about these tabs, see Synonym Editor - Synonym Text
View Tab on page 63 and Synonym Editor - Access File Text View Tab on page 64.
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Cube View Tab ObjectsReference:

The following objects appear on the Cube View tab.

DescriptionObject

Characteristics; contains the Properties and Hierarchies folders.

Optional variable.

Mandatory variable that is not satisfied (selection criteria has not been
created).

Mandatory variable that is satisfied (selection criteria has been created).

Measure.

Hierarchy.

Attribute.

Represents a leaf node in a parent/child hierarchy. A leaf node is a member
of a hierarchy that does not have any children.

Represents Level 1 in a level hierarchy.

Represents Level 2 in a level hierarchy.

Represents Level 3 in a level hierarchy.

Represents Level 4 in a level hierarchy.

Represents Level 5 in a level hierarchy.

Represents Level 6 in a level hierarchy.

Represents Level 7 in a level hierarchy.

Represents Level 8 in a level hierarchy.
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DescriptionObject

Represents Level 9 in a level hierarchy.

Represents Level 10 in a level hierarchy.

Represents Level 11 in a level hierarchy.

Represents Level 12 in a level hierarchy.

Represents Level 13 in a level hierarchy.

Represents Level 14 in a level hierarchy.

Represents Level 15 in a level hierarchy.

Represents Level 16 in a level hierarchy.

For more information about other standard objects that may appear in the Synonym Editor,
see Synonym Editor - Tree View Tab on page 53.

How to Edit Field Names and TitlesProcedure:

To edit field names and titles:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Cube Master File from the Master Files folder.

Note: You may also right-click the synonym and select Edit in Synonym Editor.

The Synonym Editor opens to the Cube View tab.

2. Select an attribute from the Cube View tab.

Note: The attributes available depend on the type of synonym.
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3. Click the FIELD NAME, TITLE, or CAPTION value field on the right-hand side of the
workspace.

Note: The Synonym Editor does not let you make any changes that would render the
Master File unusable. Therefore, you cannot edit any value field that is highlighted gray.

4. Manually edit the Field Name, Title, or Caption by typing in the value field.

The edits are updated instantaneously in the Cube View tab.

5. Click Save to save the synonym.

6. To close the synonym, select Close from the File menu or click the control button in the
upper right corner.

How to Edit Titles for Multiple LanguagesProcedure:

To edit title for multiple languages:

When a report is run using this synonym, the title is shown in all of the languages as specified
in this procedure.

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Cube Master File from the Master Files folder.

The Synonym Editor opens to the Cube View tab.

2. Select an attribute from the Cube View tab.

3. Click the browse  button, located on the far right of the TITLE or CAPTION value field.

The Multilingual Titles dialog box opens.
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4. You may add, edit or delete a title for this field.

To add an additional language for the title:

a. Select a language from the drop-down list.

b. Click Add.

c. Type in a description for the title field.

To edit an existing specified title:

a. Select the title and click Edit.

You may also double-click the title.

b. Manually type a title name.

To delete a specified title:

a. Select the title and language to be deleted.

b. Click Delete.

5. Click OK to close the Multilingual Titles dialog box.

6. Click Save from the File menu to save the synonym.

7. To close the synonym, select Close from the File menu or click the control button in the
upper right corner.

How to Delete Measures, Dimensions, or Parent/Child HierarchiesProcedure:

To delete measures, dimensions, or parent/child hierarchies:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Cube Master File from the Master Files folder.

The Synonym Editor opens to the Cube View tab.

2. Select the attribute name that you want to delete.
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3. Right-click and select Delete from the context menu.

The attribute is deleted from the Cube View tab.

4. Click Save to save the synonym.

5. To close the synonym, select Close from the File menu or click the control button in the
upper right corner.

How to Create Virtual Measures With COMPUTESProcedure:

To create virtual measures with COMPUTES:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Cube Master File from the Master Files folder.

The Synonym Editor opens to the Cube View tab.

2. Select the Measures folder from the Cube View tab.

3. Right-click and select Add Measure from the context menu.

Describing Data with Graphical Tools 107

3. Using the Synonym Editor



The Measure Calculator opens.

4. From the Measure Calculator, type a name for the column in the Column input field.

5. You may enter a descriptive title for the measure (COMPUTE) in the Title input field.

Tip: From the Synonym Editor, click the browse (...) button at the right of the TITLE and
DESCRIPTION value fields to specify multiple language titles.
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6. Use the Expression tab and the calculator buttons to build the expression for the Measure
(COMPUTE field).

or

Use the Filter Builder tab to build the expression.

a. From the Filter Builder tab, use the drop-down lists to select the filter Column,
Relation, and Type.

Note: Parameters are not supported.

b. Click the browse (...) button at the right of the Value input field.

The Value Selection dialog box opens.

c. Select from the available value(s) and use the arrows to add or remove values.

d. Click OK to close the Value Selection dialog box and return to the Filter Builder tab.

The expression is added to the value field.

e. To add another filter, double-click a column or variable from the Columns/Variables
tab on the right side of the Measure Calculator.

The filter is added to the Filter Builder. Add the expression value.

f. To delete an expression from the Filter Builder, click the red X in the row of the filter
that you are deleting. The filter is removed from the Filter Builder.
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7. You may select the Check expression and Sample Data buttons, located on the top right
of the Measure Calculator, to verify that the expression is valid and to view sample data
for the filter.

8. Click OK to close the Measure Calculator and return to the Synonym Editor.

Note: To edit the Compute Title, or Expression, you may do so directly from the Synonym
Editor or you may click the browse (...) button at the right of the EXPRESSION value field
to relaunch the Measure Calculator.
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Creating Business Views in Developer Studio

How to:

Create a Business View Using the Synonym Editor

Reference:

Business View Menu Options

Usage Notes for Business Views

Using a Business View Master File

By defining a Business View of a Master File, you can limit the fields available or create a
subset of fields from the original Master File. Fields can be grouped into meaningful folders
and field names, titles, and descriptions can be customized for each Business View. The
Business View points to its underlying Master File, and all of the actual field and security
information comes from the original Master File when the Business View is used in WebFOCUS
tools (such as Joins and Defines) and in reports.

Fields in a Business View are organized into folders. Each folder contains a group of fields.
The fields in a folder can come from different segments in the original Master File. The
Business View may contain existing fields and can include existing custom fields (DEFINEs),
COMPUTES, and Filters. Custom fields are associated with a specific segment in the original
Master File and are subject to the same rules as real fields. A report can reference fields
from multiple folders if they all lie along a single path in the original Master File.

The Business View Master File is stored as if it were a real Master File. However, it has no
SUFFIX attribute. Instead, it contains a VIEW_OF attribute that identifies it as a Business
View. It can be saved to a different application from the original Master File.

Note: Impact Analysis searches Business Views in addition to FOCUS procedures. This
enables you to see if changes in the original Master File will impact fields used in the
Business View.

You may create a Business View for an existing Master File by using the Synonym Editor.

How to Create a Business View Using the Synonym EditorProcedure:

1. From the Projects or Data Servers area in Developer Studio, navigate to the Master Files
folder where you wish to create the Business View and highlight the Master File to be
altered.

Note: You may create a Business View anywhere where you can select a Master File.
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2. Double-click the Master File or select Edit in Synonym Editor from the File menu.

The Master File opens to the Tree View tab in the Synonym Editor.

3. Select Create Business View from the Synonym menu.

The Business View window opens to the Business View Tree tab.

A default File name and folder appears. Additional folders may be created for grouping
fields.

Note: A Business View Master File may contain only one root folder.

The Properties Bar on the bottom of the Business View window shows information for
the selected fields and folders.

Tip: Use the Properties bar to change the title and descriptions for the field names.
Items that cannot be edited are grayed out.

4. To add additional folders for the Business View, select New Folder from the BusinessView
menu.

Note: Multiple sub-folders can be created and folder may be empty for organizational
purposes.
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5. Select fields from the Master File listed on the right and drag to the appropriate folder
on the left. Use Shift-click and Ctrl-click to select multiple fields.

Note: If needed, fields may be duplicated and placed under multiple folders.

The selected fields appear in the Business View Tree tab.

6. Select Save As from the File menu to save the Business View as a Business View Master
file.

Note: The Business View Master File may be saved in a different application then the
main files.

7. Select Close from the File menu to return to the Synonym Editor.
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Business View Menu OptionsReference:

The following menu items are available from the Business View window.

New Folder

Adds a new folder to the Business View. You may also access this option from the right-
click context menu and from the new folder icon, located on the Business View toolbar.

Delete Items

Deletes the selected item.

Rename Item

Enables you to rename a selected field or folder. You may also rename items from the
Properties bar and the from the right-click context menu.

Refresh

Refreshes the Business View. A Refresh icon is also available on the Business View
toolbar.
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Use Application Directory Names

Specifies the application name where the original file exists. Information is written in
the new master file. The following image is an example of the application directory name
for the business view.

Note: This option is turned off by default and is only available during the creation of the
business view.

Sample Data

Test the business view for field data and view the type of records returned.

Impact Analysis

Opens the Impact Analysis tool which enables you to analyze data, control search criteria,
save reports, and interactively open and edit procedures based on search results.

Exposed Synonym

Shows the Synonym referenced by the Business View.

Properties Bar

Shows the Properties Bar where you may edit properties for the selected fields and
folders. Items that cannot be edited are grayed out.

Note: The Properties Bar may be moved or docked anywhere on the Business View
window.

Business View Tree

Shows the contents of the Business View in the Business View Tree. This is the default
option.
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Text View

Shows the contents of the Business View in the Text View. You may also select this
option by clicking the Text View tab from the bottom of the Business View window.

Note: The text view is read-only. You cannot edit the underlying description from this
tab.

Usage Notes for Business ViewsReference:

The detailed information about fields, such as USAGE and ACTUAL formats or indexes
remain in the original Master File.

All information about Cluster Master Files remain in the original Master File.

DBA attributes are only allowed in the original Master File and are respected by the
business view.

When a Master File description contains more than one field with the same name, as
can occur when files are joined, the BELONGS_TO_SEGMENT attribute identifies which
instance of the field name is being referenced in the Business View.

Folders can be empty for organizational purposed. For example, Region can have empty
folders called North, South, East, and West.

You can issue an SQL SELECT command against a Business View. However, a Direct
SQL Passthru request is not supported against a Business View.

Business Views support alternate file views and fully qualified field names.

The SEG. operator against a Business View folder displays all of the fields in that folder,
not all of the fields in the real segment.

Requests against a Business View cannot reference any fields or segments not in the
Business View.

All HOLD formats are supported against a Business View.

All adapters for non-FOCUS data sources support retrieval requests against a Business
View.

Business Views are not supported with data source maintenance commands such as
Maintain or REBUILD.

Business Views are not available for Cube Data Sources.

For OLAP enabled Master Files, dimensions are not visible while creating a business
view. Only fields from the original Master File will be visible.
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When using Business Views, the following SET command must be specified: SET
FOCTRANSFORM=ON. This SET command can be placed in a procedure or can be set in
the global server profile or specified in a user profile and can be set while using the
Business View or regular Master Files. For thin client tools (Power Painter, Advanced
Graph Assistant, HTML tools, and so on), it needs to be in the profile as end-users do
not have access to the SET tool or ability to access an editor and manually enter the
required command.

Adding this SET command in the profile is a good practice as it will avoid errors during
reporting in case command is missing and users will not need to be concerned about
what type of file they are using during reporting (Business View or existing master file).

Using a Business View Master FileReference:

When you use the Business View Master File in the WebFOCUS tools and reports, the Field
formats, descriptions and titles will be retrieved from the original Master File, unless they
are customized and a title and description is available through the Business View.

You may access the Business View Master Files from all development areas of Developer
Studio:

In the Projects, Data Servers or Managed Reporting area:

The Table list shows all available Master Files including the Business Views that are available.
The Remarks column shows a description from original Master File unless the Business
View file contains it own remarks.
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The following image is an example of a Business View Master FIle in the WebFOCUS Table
List, that appears when creating a report in the Data Servers area.

This is also available in the Projects area, however the table list does not show remarks in
the Projects area.
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In the Report Painter:

When using a Business View Master File in the Report Painter, only fields from the Business
View are shown in the Fields list.

The following image is an example of a Business View Master File in the Report Painter.

In the Managed Reporting Report Assistant:

When using a Business View Master File with the Report Assistant, only fields from the
Business View are shown in the Fields list.

Describing Data with Graphical Tools 119

3. Using the Synonym Editor



The following image is an example of a Business View Master File in the Managed Reporting
Report Assistant.

Adding Virtual Columns (DEFINE) in a Synonym

How to:

Create a Virtual Column in a Synonym

You may create a DEFINE field as a custom field in the Synonym Editor. A custom field can
be used in a request as though it is a real data source field. Virtual columns (DEFINES) are
available when the data source is used for reporting.

A virtual column can contain an expression, a constant, or a column name.

If the virtual column is a complex expression, you can create the expression with the
Virtual Column Calculator or just type it into the Expression field.

If the virtual column is a simple expression, like a constant value, you can type the value
in the Expression field.
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Virtual columns are designated by the following icon:

After creating a virtual column, you can test it by right-clicking the synonym and selecting
Sample Data. Sample Data appears in a separate dialog box.

How to Create a Virtual Column in a SynonymProcedure:

To create a virtual column in a synonym:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens.

2. Right-click a segment (or column) and click Add.

3. Select Virtual Column from the Add submenu.

The Virtual Column Calculator opens.

4. From the Virtual Column Calculator, type a name for the column in the Column input
field, or use the default define name.
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5. You may enter a descriptive title for the virtual column (DEFINE) in the Title input field.

Tip: From the Synonym Editor, click the browse (...) button at the right of the TITLE and
DESCRIPTION value fields to specify multiple language titles.

6. Use the Expression tab and the calculator buttons to build the expression for the virtual
column (DEFINE).

or

Use the Filter Builder tab to build the expression.

a. From the Filter Builder tab, use the drop-down lists to select the filter Column,
Relation, and Type.

Note: Parameters are not supported.

b. Click the browse (...) button at the right of the Value input field.

The Value Selection dialog box opens.

c. Select from the available value(s) and use the arrows to add or remove values.
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d. Click OK to close the Value Selection dialog box and return to the Filter Builder tab.

The expression is added to the value field.

e. To add another filter, double-click a column or variable from the Columns/Variables
tab on the right side of the Virtual Column Calculator.

The filter is added to the Filter Builder. Add the expression value.

f. To delete an expression from the Filter Builder, click the red X in the row of the filter
that you are deleting. The filter is removed from the Filter Builder.

7. You may select the Check expression and Sample Data buttons, located on the top right
of the Virtual Column Calculator, to verify that the expression is valid and to view sample
data for the filter.

8. Click OK to close the Virtual Column Calculator and return to the Synonym Editor.

Note: To edit the DEFINE, Title, or Expression, you may do so directly from the Synonym
Editor or you may click the browse (...) button at the right of the EXPRESSION value field
to relaunch the Virtual Column Calculator.

9. If no columns from the synonym are used in the expression or have been defined, you
can use the WITH option to identify the logical home of the defined calculation. You can
also use the WITH option to move the logical home for the virtual column to a lower
segment than it would otherwise be assigned to (for example, to count instances in a
lower segment).

Tip: You can click and drag the DEFINE field and move it to a different segment in the
Tree View tab, which also changes the segment association.
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10. Specify the Missing Data options for columns that allow null data. You can allow all
missing data.

11. Click Save from the File menu to save the synonym.

12. To close the Synonym Editor, select Close from the File menu or click the control button
in the upper right corner.

For more information about expressions and virtual column (DEFINE) attributes, see Defining
Attributes and Creating Expressions for Custom Fields on page 132.

Creating Filters in a Synonym

How to:

Create Filters in a Synonym

Filters are created in the Master File through the Synonym Editor and can be used in a
Business View file or in reporting tools such as Report Painter, Power Painter, HTML Report
Assistant, and so on. You can also use filters to perform other data checking and validation,
and sort data based on the conditions that you create.

Filters are created under a specific segment and by default they have association with the
selected segment. Filters can also be created without segment association.
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How to Create Filters in a SynonymProcedure:

1. From the Projects or Data Servers area, double-click a synonym from the Master Files
folder, or right-click the synonym and select Edit in Synonym Editor.

The Synonym Editor opens.

2. Right-click a segment or field and select Filter from the Add submenu.

The Filter Calculator opens.

3. From the Filter Calculator, type a name for the filter in the Column input field, or use the
default Filter name.

Note: It is recommended that filters have a descriptive name to help identify the filter
action during reporting.

4. The Format field shows a default value of I1.

Note: The format field cannot be changed. Values for filters return 0 for false and 1 for
true.

5. You may enter a descriptive title for the filter in the Title input field.

Tip: From the Synonym Editor, click the browse (...) button at the right of the TITLE and
DESCRIPTION value fields to specify multiple language titles.

6. Use the Expression tab and the calculator buttons to build the expression for the filter.

or

Use the Filter Builder tab to build the expression.
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a. From the Filter Builder tab, use the drop-down lists to select the filter Column,
Relation, and Type.

Note: Parameters are not supported with Master File Filters.

b. Click the browse (...) button at the right of the Value input field.

The Value Selection dialog box opens.

c. Select from the available value(s) and use the arrows to add or remove values.
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d. Click OK to close the Value Selection dialog box and return to the Filter Builder tab.

The expression is added to the value field.

e. To add another filter, double-click a column or variable from the Columns/Variables
tab on the right side of the Filter Calculator.

The filter is added to the Filter Builder. Add the expression value.

f. To delete an expression from the Filter Builder, click the red X in the row of the filter
that you are deleting.

The filter is removed from the Filter Builder.

7. You may select the Check expression and Sample Data buttons, located on the top right
of the Filter Calculator, to verify that the expression is valid and to view sample data for
the filter.

8. Click OK to close the Filter Calculator dialog box to return to the Synonym Editor.

Note: To edit the Filter, Title, or Expression, you may do so directly from the Synonym
Editor or you may click the browse (...) button at the right of the EXPRESSION value field
to relaunch the Filter Calculator.
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9. To create a Filter without segment association, use the WITH drop-down list to select a
blank segment.

Note: Filters are created under a specific segment and by default they have association
with the selected segment. Filters can also be created without segment association.

Note: If using a field that appears in multiple segments, the WITH segment associated
should be the lowest level segment, or it should be left empty to prevent errors.

In addition, If no fields from the synonym are used in the expression or have not been
computed, you can use the WITH option to identify the logical home of the Filter
calculation. You can also use the WITH option to move the logical home for the Filter
field to a lower segment than it would otherwise be assigned to (for example, to count
instances in a lower segment).

10. Click Save from the File menu to save the synonym.

The filter is saved as part of the synonym.

11. To close the Synonym Editor, select Close from the File menu or click the control button
in the upper right corner.

Adding Computed Fields (COMPUTE) in a Synonym

How to:

Create a Computed Field in the Synonym Editor

You may create a Computed field as a custom field in the Synonym Editor. The procedure
for adding a custom field is similar to the procedure used to add a Defined field. The
Computed field is identified as the Master File Computed Field and is differentiated from
the Defined fields and the other Computed Fields.

Note: Computed fields from the Master File appear in the Windows versions of the Graph
Assistant and in the Report Painter fields list.
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How to Create a Computed Field in the Synonym EditorProcedure:

To create a computed column in a synonym:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens.

2. Right-click a segment (or column) and click Add.

3. Select Compute  from the Add submenu.

The Compute Calculator opens.

4. From the Compute Calculator, type a name for the column in the Column input field, or
use the default compute name.

5. You may enter a descriptive title for the computed field (COMPUTE) in the Title input
field.

Tip: From the Synonym Editor, click the browse (...) button at the right of the TITLE and
DESCRIPTION value fields to specify multiple language titles.

6. Use the Expression tab and the calculator buttons to build the expression for the
computed field (COMPUTE).

or

Use the Filter Builder tab to build the expression.
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a. From the Filter Builder tab, use the drop-down lists to select the filter Column,
Relation, and Type.

Note: Parameters are not supported.

b. Click the browse (...) button at the right of the Value input field.

The Value Selection dialog box opens.

c. Select from the available value(s) and use the arrows to add or remove values.
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d. Click OK to close the Value Selection dialog box and return to the Filter Builder tab.

The expression is added to the value field.

e. To add another filter, double-click a column or variable from the Columns/Variables
tab on the right side of the Compute Calculator.

The filter is added to the Filter Builder. Add the expression value.

f. To delete an expression from the Filter Builder, click the red X in the row of the filter
that you are deleting.

The filter is removed from the Filter Builder.

7. You may select the Check expression and Sample Data buttons, located on the top right
of the Compute Calculator, to verify that the expression is valid and to view sample data
for the filter.

8. Click OK to close the Compute Calculator and return to the Synonym Editor.

Note: To edit the Compute, Title, or Expression, you may do so directly from the Synonym
Editor or you may click the browse (...) button at the right of the EXPRESSION value field
to relaunch the Compute Calculator.

9. Specify the Missing Data options for columns that allow null data. You can allow all
missing data.

10. Click Save from the File menu to save the synonym.

11. To close the Synonym Editor, select Close from the File menu or click the control button
in the upper right corner.

For more information about expressions and COMPUTE attributes, see Defining Attributes
and Creating Expressions for Custom Fields on page 132.
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Defining Attributes and Creating Expressions for Custom Fields

Reference:

Custom Field Attributes

Calculators for Custom Fields

A custom field is a field whose value is not stored in the data source but can be calculated
from the data that is there. You can create a custom field in your synonym by adding a virtual
column (DEFINE), Master File filter (FILTER) and a Computed Field (COMPUTE). The fields
are available whenever you access the corresponding data source in a reporting tool.

You can define attribute values and create expressions for custom fields by using the
Synonym Editor.

Custom Field AttributesReference:

The following attributes may be available for custom fields (DEFINE, FILTERS, and COMPUTE)
in the Synonym Editor.

Note: The attributes available depend on the type of synonym and the type of custom field
selected. The image below is an example of a Microsoft SQL Server data source with the
virtual column (DEFINE) selected.
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Custom fields (DEFINE, FILTER, COMPUTE) typically have the following attributes:

General

DEFINE

Is the name of the virtual column.

Note: This attribute only appears when a virtual column (DEFINE) is selected.

FILTER

Is the name of the Master File filter field.

Note: This attribute only appears when a virtual Filter field is selected.

COMPUTE

Is the name of the computed field.

Note: This attribute only appears when a virtual computed field is selected.

EXPRESSION

Is the calculation that creates the virtual column.

TITLE

Supplies a title to replace the column name that is normally used in reports and
enables you to specify multiple language titles for the virtual column.

FORMAT

Describes the data type and format for the virtual column.

Note: This attribute only appears for DEFINE and COMPUTE custom fields.

Allow Missing Data

Allows missing data if not, transaction value is supplied.

Note: This attribute only appears for DEFINE and COMPUTE custom fields.
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All

Allows all missing data if not transaction value is supplied.

Note: This attribute only appears for DEFINE and COMPUTE custom fields.

Miscellaneous

REDEFINES

A Define expression may not contain qualified field names. REDEFINES enables you
to redefine or recompute a column whose name exists in more than one segment.

Note: This attribute only appears for DEFINE custom fields and cannot be used by
WebFOCUS  or iWay.

WITH

If no columns from the synonym are used in the expression or have been defined,
you can use the WITH option to identify the logical home of the defined calculation.
You can also use the WITH option to move the logical home for the virtual column
to a lower segment than it would otherwise be assigned to (for example, to count
instances in a lower segment).

Note: This attribute only appears for DEFINE and FILTER custom fields.

DESCRIPTION

Contains a description or comments about the virtual column.

WITHIN

Contains the name of a field to be included in a dimension.

These WITHIN statements are added to the synonym through the Dimension Builder
to OLAP enable FOCUS files and relational tables. This enables you to perform OLAP
analysis using the Developer Studio OLAP Control Panel, or to use it with the FML
Painter.

Note: This attribute only appears for DEFINE and FILTER custom fields.
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SCD Type

Sets slowly changing dimensions. This option is only available for existing relational
targets.

A surrogate key is the first column in the table and has an SCD type of blank.
Other columns with a blank SCD type have no SCD processing done to them.

Logical Key Field is the database key.

Activation Flag indicates that the row is current.

Begin Date/End Date indicates date range for the row values. A null end date
indicates the row is current.

Type I (overwriting history) designates columns whose database values are
overwritten with new values.

Type II (preserving history) designates columns that whose database rows are
flagged as inactive or assigned an end date; new rows are inserted with the new
values.

blank (non-key columns) indicates that database values are not changed.

Note: The attributes available depend on the type of synonym.
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Calculators for Custom FieldsReference:

To launch the Virtual Column Calculator, Filter Calculator, or Compute Calculator, click the
browse (...) button at the right of the EXPRESSION value field in the Synonym Editor.

The selected calculator opens., depending on the type of custom field that you are creating.

The calculator has the following fields/options:

Column

The name of the object being created (virtual field, filter, computed field).

Format

Is the fields format.

Expressions tab

Location for typing an expression. You can add data source fields from the
Columns/Variables tab, functions from the Functions tab, and numbers and operators
from the calculator as you type.

Filter Builder tab

Displays the filter building window from which you can add and delete columns, choose
the relation, type, and select values for your filter.

136 WebFOCUS7

Defining Attributes and Creating Expressions for Custom Fields



Columns/Variables tab

Displays a hierarchical list of available source columns, and System Variables folders
that you can use in creating an expression.

Functions tab

A function is a program that returns a value. This tab lists the built-in functions that you
can use to derive the value of a temporary field.

Function Assist button

Enables you to specify parameters for the function through a dialog box when creating
or editing a transformation.

Calculator buttons

Insert numbers and operators.

The following operators are available:

| (single concatenation bar)

Concatenates two values, retaining any trailing blanks after the first one. For example,
if FIRST_NAME and LAST_NAME were both in A15 format, the expression

FULL_NAME = FIRST_NAME | LAST_NAME

would produce a column like the following:

MICHAEL      SMITHSONJANE         JONES
.
.
.

|| (double concatenation bar)

Concatenates two values, suppressing any trailing blanks in the first. For example,
to construct the full name and insert a comma, the syntax

FULL_NAME = LAST_NAME || (', ' | FIRST_NAME)
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would produce a column like the following:

SMITHSON, MICHAEL JONES, JANE
.
.
.

The concatenation in the parentheses is done first (preserving the blank space after
the comma), and the result is then concatenated to LAST_NAME, suppressing the
trailing blanks of LAST_NAME.

IF

Establishes a conditional test.

THEN

Specifies the action to perform if the result of a conditional test is TRUE.

ELSE

Specifies the action to perform if the result of a conditional test is FALSE.

LT

Returns the value TRUE if the value on the left is less than the value on the right.

NOT

Returns the value TRUE if the operand is false.

LE

Returns the value TRUE if the value on the left is less than or equal to the value on
the right.

EQ

Returns the value TRUE if the value on the left is equal to the value on the right.

AND

Returns the value TRUE if both operands are true.
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GT

Returns the value TRUE if the value on the left is greater than the value on the right.

GE

Returns the value TRUE if the value on the left is greater than or equal to the value
on the right.

NE

Returns the value TRUE if the value on the left is not equal to the value on the right.

OR

Returns the value TRUE if either operand is true.

**

Raises a value to the specified power.

( )

Adds parentheses.

''

Inserts two single quotation marks. Enter alphanumeric test values between these.

a->A

Converts selected text to uppercase.

A->a

Converts selected text to lowercase.

Check expression button

Verifies the validity of the expression.
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Sample data button

Produces sample data for the expression.

Adding Group Fields in a Synonym

How to:

Add a Group Field to a Segment

Add a New Field to a Group Field

Add an Existing Field to a Group Field

Delete a Group Field From a Segment

Delete a Field From a Group Field

Reference:

Group Field Attributes

For data sources that support groups, you can assign a unique name to multiple fields to
create a group field. A group field is created by two or more alphanumeric fields, physically
next to each other. A group field provides an efficient means for grouping similar or logically
connected fields that will be accessed as a single unit, but do not warrant a separate
segment.

Note: In the Maintain environment group fields are supported in a Master File as long as
they are not group keys, that is groups that are actual fields, as supported by VSAM. If you
create a group field in the Maintain environment, the group will not be visible, only the fields
that make up the group will be visible.
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How to Add a Group Field to a SegmentProcedure:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens.

2. Right-click a segment (or column) and click Add.

3. Select Group  from the Add submenu.

Note: The groups option may not be available for some data sources.

A group is added to the synonym and its attributes and values appear on the right.

4. Type a name for the group in the GROUP field.

5. Select the USAGE Type value for the group. Specify the length, the decimal places (if
applicable) and any display options for the group.

6. Click the I - Index box if you want the group to be indexed.

7. Select the ACCESS_PROPERTY values to specify access options for the group's data.

8. Optionally, you can specify the TITLE and DESCRIPTION display options.

9. Click Save from the File menu to save the synonym.

10. To close the Synonym Editor, select Close from the File menu or click the control button
in the upper right corner.
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How to Add a New Field to a Group FieldProcedure:

1. Right-click the group field to which you want to add a new field and select Add.

2. Select Column  from the Add submenu.

A field is added to the group and its attributes and values appear on the right.

3. Supply the required information for the group field. For more information about field
attributes, see Viewing and Editing Synonym Attributes on page 66.

How to Add an Existing Field to a Group FieldProcedure:

1. Click the field you want to add to the group field.

2. While holding the left mouse button down, drag the field and drop it on the group field
name.

The field is added to the group field.
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How to Delete a Group Field From a SegmentProcedure:

1. Right-click the group and select Delete.

A confirmation appears stating that all fields \ columns within the group will be deleted.

2. Click Yes to delete the group and move the fields (within the group) under the root
segment of the synonym.

Click No to delete the group and all of the fields within the group.

Click Cancel to close the Confirmation Delete dialog box and return to the Synonym
Editor.

How to Delete a Field From a Group FieldProcedure:

Right-click the field, then select Delete.

Group Field AttributesReference:
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Group fields in a synonym can have the following attributes:

General

GROUP

Is the name of the group.

ALIAS

Assigns an alternative name for a group.

If you create a report, the group name appears as a column heading unless you have
specified an alternate title for the group. Aliases cannot be used as column titles.

TITLE

Supplies a title to replace the group name that is normally used in reports and
enables you to specify multiple language titles for the group.

USAGE

Contains the format for the group field. Since the group field is made by concatenating
together several other fields, the Synonym Editor determines what this format needs
to be. For example, if the group field has two alphanumeric fields in it, each 20
characters long (A20), then the group field must be alphanumeric and 40 characters
long (A40). The group field is always alphanumeric, regardless of what the fields
that make it up are.

Miscellaneous

DESCRIPTION

Contains a description or comments about the group. The description displays in
Field lists and on the status bar.

Field descriptions also appear as bubble help in OLAP-enabled reports. If you do not
include a description, bubble help shows the field name (column title). For information
on displaying bubble help in OLAP-enabled reports, see the Creating Reports With
Graphical Tools manual.
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FIELDTYPE

Identifies an indexed group. You can index the values of a field to enhance data
retrieval performance. To do so, select the Index check box when you add a field
and before you add the data. An index is an internally stored and maintained table
of data values and locations that enhance the performance of data retrieval. A Master
File can have several associated indexes, but the combined total of indices and
segments cannot exceed 64.

Note: FIELDTYPE=R indicates a read-only column. This setting is useful for columns
are that automatically assigned a value by the RDBMS, such as a Sybase or MS SQL
Server Identity or Timestamp column.

Tip: You can turn on the index after adding data to a field, however, you will have to
use the Rebuild Index option to create the index.

ACCESS_PROPERTY

Specifies access options for the column's data.

INTERNAL defines a column that does not appear in sample data or in the list of
available columns. Restricts the field from showing in any of the Field Lists in the
reporting tools.

NEED_VALUE defines a column that requires a value to access the data. Indicates
that a selection is needed in the Report Request (WHERE condition).

Select By defines a column by value, range, or multivalues.

If Value is checked, only one value should be defined for selection in the Report
request.

If Range is checked, a range selection should be defined in the Report request.

If Multivalues is checked, multiple values are allowed for selection in the Report
request.

Note: The attributes available depend on the type of synonym.
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Applying Database Administrator Security

In this section:

Encrypting and Decrypting a Master File

Selecting the Type of Access

Restricting Access to Segments, Fields, and Field Values

Applying Security Restrictions for Multiple Users

Deleting a DBA or User's Password

How to:

Set Up Security for the Database Administrator

Set Up Security for the User

Reference:

DBA Guidelines

DBA Properties Dialog Box

You can secure Master Files on a file-by-file basis. For each data source, security can be
maintained at two different levels.

Database Administrator Level. You specify the Database Administrator (DBA) password
for the data source. The DBA has unlimited access to the Master File and data source
and can set up or change security restrictions for individual users. Only the Database
Administrator can encrypt (scramble) or decrypt (unscramble) a data source. For more
information, see Encrypting and Decrypting a Master File on page 151.

User Level. You specify the DBA and user passwords for the data source. The user
password represents a user who has access to that data source. When you specify a
user password, you must also set at least the type of file access: read, write, read/write,
update. Each user's security can be further limited by restricting access to segments,
fields, or field values. For more information, see Restricting Access to Segments, Fields,
and Field Values on page 153. Once a user password has been established, you can apply
the same restrictions to multiple users. For more information, see Applying Security
Restrictions for Multiple Users on page 155.

Note: You cannot specify a Database Administrator (DBA) password during the create
synonym process. You must use the Synonym Editor.

When security is specified, the Database Administrator, or user, must enter a password to
get access to the data source. When the DBA or user no longer has access to the data
source, you can delete their security.
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Before adding any type of security to a data source, the Database Administrator must be
aware of certain DBA guidelines. See DBA Guidelines on page 148.

How to Set Up Security for the Database AdministratorProcedure:

1. In the Synonym Editor, click DBA from the Synonym menu or click the DBA  button
from the Synonym toolbar.

The DBA Properties dialog box opens.

2. Type the DBA password in the DBA Password box.

Note: When the password is created and the cursor is in that field, you can right-click
and use the edit options to undo, select all, cut, copy, paste, or delete the password.

3. Click OK to save the Master File with the DBA password.
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How to Set Up Security for the UserProcedure:

1. In the DBA Properties dialog box, click Add Users.

Note: The Add Users button is not active until you enter a DBA password.

The User in File, File Access, and Access Restrictions options are activated.

2. Select the type of file access from the File Access group.

Note: When the password is created and the cursor is in that field, you can right-click
and use the edit options to undo, select all, cut, copy, paste, or delete the password.

3. Select the type of restriction—segment, field, and/or field value—from the Access
Restrictions group, then select the type of access for each. For details, see Restricting
Access to Segments, Fields, and Field Values on page 153.

4. To apply the same security restrictions as another user, select the Same Restriction
check box and select another user from the drop-down list.

Note: The Same Restriction option is activated when there are multiple users.

5. You may select the User in File browse button to select a Master File to which the user
security will be applied.

Note: The User in File option is activated when a user is selected.

6. Click OK to save the Master File with the user password and restrictions.

DBA GuidelinesReference:

You can ensure that the security restrictions you place on Master Files are correct by adhering
to these guidelines.

Every file with access limits must have a DBA password.

No segment, field, or field value restrictions may be specified at the Database
Administrator level. The Database Administrator should have unlimited access to the
data source and all cross-referenced data sources.

Once security restrictions have been applied, the Database Administrator should conduct
thorough testing of every restriction before the data source is used. It is particularly
important to check field values to make sure they do not contain errors. If they are in
error, user access to the field data will be unnecessarily restricted.

All groups of cross-referenced data sources must have the same security restrictions.

You must have a DBA password to encrypt and decrypt or restrict existing data sources.

The Database Administrator can change any type of security restriction.
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Access levels effect what fields users can access. The Database Administrator must
consider what commands each user will need. If a user does not have access rights,
that user will receive an error message.

DBA Properties Dialog BoxReference:

The following options are available from the DBA Properties dialog box.

DBA Password

Enter your DBA password of up to 8 characters. This is the password of the DBA who
will be creating and maintaining the current data source. The DBA has full access to the
data source and the corresponding Master File, controls the access rights of other users,
and has encryption privileges. See Encrypting and Decrypting a Master File on page 151.

DBA File

Select the name of the Master File that contains your DBA security restrictions. Other
Master Files can use the DBA security restrictions in this Master File.
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User in File

Select the name of the Master File to which a user security will be applied. This option
is used to add data source-specific restrictions to the current data source. It includes a
FILENAME attribute for the selected Master File. The FILENAME attribute in the referenced
Master File must be the same as the FILENAME attribute in the DBA section of the
current data source.

Users

Enter the names (up to eight characters) of users to whose access rights will be granted
for the current data source.

Same Restriction: User Same as

If multiple users require the same access rights, indicate the user whose access profile
you wish to apply and the new user to whom you wish to apply it. See Applying Security
Restrictions for Multiple Users on page 155.

File access

Choose Read access for full viewing rights.

Choose Write access to permit additions/changes to the data source.

Choose Read/Write for both of the above.

Choose Update access to make changes to field values.

Access Restrictions

Name - Name of the Master File component selected (for example, the segment or field
name).

Access - Type of access restriction.

Value - Value to restrict access to.

Segment, Field, Value

Choose Segment to grant access to all or individual segments.

Choose Field to grant access to all or individual fields.

Choose Value to limit access to values that meet a test condition. See Restricting Access
to Segments, Fields, and Field Values on page 153.
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Encrypting and Decrypting a Master File

How to:

Encrypt a Master File

Decrypt a Master File

You may use the Encrypt and Decrypt attributes from the Synonym Editor to scramble and
unscramble some or all of the contents of a data source. When you encrypt Master Files,
they are secure from unauthorized examination.

Encryption at the data source level scrambles the entire contents of that Master File so it
is unreadable. When you encrypt a Master File, you can decrypt it. Decrypting unscrambles
the contents to its readable state.

Before you can encrypt or decrypt any Master File, you must specify the DBA password. If
you do not specify a DBA password, you will not be able to encrypt or decrypt.

How to Encrypt a Master FileProcedure:

1. In the Synonym Editor, click DBA from the Synonym menu or click the DBA  button
from the Synonym toolbar.

The DBA Properties dialog box opens.

2. Create and save the Master File with the DBA password.

3. From the Synonym Editor Tree View tab, select a segment from the Master File hierarchy
(left pane).

The values for the selected segment appear in the right pane.
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4. Select the Encrypt check box.

5. Click Save from the File menu to encrypt the Master File.

How to Decrypt a Master FileProcedure:

1. At the encrypted segment level in the Master File hierarchy (left pane), click the Encrypt
attribute.

2. De-select the Encrypted check box.

3. Click Save from the File menu to decrypt the Master File.

Selecting the Type of Access

When you assign a user password, the type of file access and access restrictions options
are available. You must specify at least the type of access the user is permitted to have for
the data source. The type of file access can be specified in the File Access group on the
DBA Properties dialog box. In this group, there are four file access options:

Read. Allows the user only to read (to view) the data source.

Write. Allows the user only to write (to add or to make changes) to the data source.

Read/Write. Allows the user to read and write to the data source.

Update. Allows the user to update (to make changes to) existing field values.

The type of file access determines what a user can do to the entire data source:
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If you specify only the type of file access, the user will have the specified access to the
entire data source.

If you want to impose additional limitations you can restrict access to segments, fields,
and/or field values. See Restricting Access to Segments, Fields, and Field Values on page
153.

Restricting Access to Segments, Fields, and Field Values

You can restrict access to segments, fields, and field values in a Master File by specifying
Access Restrictions for a user. When you specify what is to be restricted—segment, field,
and/or value—you can then specify the type of access that will be restricted. For fields, you
can also specify whether or not you want the field to be displayed. For field values, you are
required to enter a test condition.

Select the Segment/Field/Value button from the Access Restrictions area in the DBA
Properties dialog box and specify the restriction.

Segments. You specify the type of access for individual segments or all segments.
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Fields. You specify the type of access for individual fields or all fields. You can also
specify not to display the data in that field using NoPrint. If you specify NoPrint for a field,
the data will appear as blanks for alphanumeric format or zeros for numeric format
whenever the user tries to retrieve it.
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Values. You specify the type of access (read or write) and the test condition. The user
is restricted to using only those values that satisfy the test condition.

Applying Security Restrictions for Multiple Users

How to:

Apply Previously Defined Restrictions to Another User

You can specify restrictions for one user and apply the same restrictions to other users.
This helps when you want to set the same restrictions for a group of users.

How to Apply Previously Defined Restrictions to Another UserProcedure:

1. In the DBA Properties dialog box, click Add Users.

Note: The Add Users button is not active until you enter a DBA password.

The Same Restrictions group is activated.

Note: The Same Restriction option is activated when there are multiple users.

2. In the Same Restriction group, click the User Same as check box.
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3. Click the arrow on the drop-down combo box, then select the user with the security
restrictions that would apply to the new user. Security restrictions from the user in the
User Same as box are applied to the new user. You can apply the security restrictions
to other users by repeating steps 1 to 3.

Note: You must have created at least one user security restriction to apply security
restrictions to multiple users.

Deleting a DBA or User's Password

How to:

Delete a User's Password

Delete a DBA Password

You can delete a DBA or user's security when it is no longer needed.

How to Delete a User's PasswordProcedure:

1. On the DBA Properties dialog box, select the user name in the Add Users box.

2. Right-click and select Delete or press Delete on the keyboard. A confirmation message
appears asking if you want to delete the security information for the selected user.

3. Select Yes.

If you delete the user based upon whom you have assigned security restrictions for other
users, you must reset security restrictions for all users attached to the user you deleted.

How to Delete a DBA PasswordProcedure:

Note: Deleting a DBA's security will delete all users' security for that data source.

1. From the DBA Password box, right-click and select Delete or press Delete on the keyboard.
A confirmation message appears stating that no DBA password is defined.

2. Select Yes.

All security information is removed.
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Analyzing Metadata and Procedures4
Topics:

Describes how to analyze procedures
using Impact Analysis, and how to view
Data Profiling for the columns in a
synonym.

Analyzing Procedures With the Impact
Analysis Tool

Viewing Data Profiling Characteristics
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Analyzing Procedures With the Impact Analysis Tool

How to:

View Impact Analysis Results from the Synonym Editor

Use the Impact Analysis Tool From the Developer Studio Interface

You can use the Impact Analysis tool to generate a report that identifies the procedures that
access a specific Master File or field within a Master File. This tool helps you analyze the
potential impact of modifying or deleting Master Files or fields. The Impact Analysis tool
enables you to analyze data, control search criteria, save reports, and interactively open
and edit procedures based on search results.

Note: Impact Analysis searches Business Views in addition to FOCUS procedures. This
enables you to see if changes in the original Master File will impact fields used in the
Business View. For more information about Business Views, see Creating Business Views in
Developer Studio  on page 111.

The Impact Analysis tool is accessible from the Projects, Data Servers, and Managed
Reporting areas of Developer Studio and is supported for Windows, UNIX, and z/OS
configurations.

Note: Impact Analysis can be launched from the Developer Studio interface or from within
the tools in the Synonym Editor and Business Views. When Impact Analysis is launched from
the Synonym Editor or Business Views, it searches files based on the application path of
the reporting server. From the Developer Studio interface, it enables you to select
applications/domains to be searched.

How to View Impact Analysis Results from the Synonym EditorProcedure:

When Impact Analysis is launched from within the Synonym Editor, it searches files based
on the application path of the reporting server.

1. From the Projects or Data Servers area in Developer Studio, double-click the Master File
or select Edit in Synonym Editor from the File menu.

The Master File opens to the Tree View tab in the Synonym Editor.

2. Select the Synonym File name, or a column field, right-click and select Impact Analysis
from the context menu.
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The following image shows the context menu used to launch the Impact Analysis tool.

Note: Impact Analysis is also available from the Business View tab.

The Impact Analysis results are displayed in a report spreadsheet.

3. You may use the results toolbar to view server messages, print the report, copy data
as text, and export the report.

4. Click Save from the File menu to save the Impact Analysis results.

5. Click Close from the File menu to close the Impact Analysis results window and return
to the Synonym Editor.

How to Use the Impact Analysis Tool From the Developer Studio InterfaceProcedure:

1. From the Projects or Data Servers area in Developer Studio, highlight a Master File and
select Impact Analysis from the File menu.

Note: You may also select a Impact Analysis from the right-click context menu of a
Master File. This interface enables you to select applications or domains to search.

The Impact Analysis tool opens with the New Report tab displaying the selected (Master)
File Name and default Search Paths.
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2. To search for all procedures that access a specific Master File or field, perform one of
the following:

For the Master File you selected when opening the tool, it will be searched by
default. (Go to the next numbered step.)

For a different Master File, click the ellipsis button to the right of the File Name
search field and select a different Master File in the Open dialog box that opens.

For a single field within a Master File, after you select the desired Master File,
click the ellipsis button to the right of the Field Name search field and double-click
a field name in the Master File pop-up box.

3. Optionally, to search for procedures in directory paths not listed by default in the Search
Paths pane, add more search paths by clicking the folder icon above the Search Paths
area and selecting one or more folders in the Browse for Folder dialog box that opens.

Note: You can also delete search paths by highlighting a search path and clicking the
Delete icon above the Search Paths area.

4. Click Analyze to display a report in the Impact Analysis Results pane.
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The following image shows the New Report tab of the Impact Analysis dialog box
populated with File Name search criteria, multiple Search Paths, and a report displayed
in the Impact Analysis Result pane.

You have options to edit procedures, print the report, delete an item in the report, and
export a report.

Exported reports are XML formatted, have an .IAR extension, and are saved in the
following default directory (unless you specify a different location):

drive:\ibi\DevStudioreleasenumber\bin

5. Click the Saved Reports tab to access all previously created reports.

All Impact Analysis reports are automatically saved in the following XML formatted file
(unless you manually delete a report):

drive:\ibi\DevStudioreleasenumber\bin\IARepository.xml

Information is appended to this file as new analysis reports are performed. You have
options to view reports, import previously exported reports, and delete reports.
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Viewing Data Profiling Characteristics

In this section:

Data Profiling a Synonym or Segment

Data Profiling a Single Column

Data Profiling provides data characteristics for the columns in a synonym. You can display
the characteristics for all the columns in a synonym or segment, or for an individual column.

Note: Data Profiling is not available if your adapter is not configured correctly. For more
information about configuring the adapter, see Accessing Data and Creating Synonyms on
page 15.

For alphanumeric columns, Data Profiling provides the segment, format, count of distinct
values, total count, patterns count, maximum, minimum, and average length, and number
of nulls. Patterns count shows the number of patterns found in each alphanumeric column.

For numeric columns, Data Profiling provides the segment, format, count of distinct values,
total count, maximum, minimum, and average value, and number of nulls.

Data Profiling for an individual column provides access to Statistics, Patterns, Values, and
Outliers reports.

Data Profiling a Synonym or Segment

How to:

View Data Profiling for a Synonym or Segment

Data Profiling provides information on all the columns in a synonym or segment. You can
also drill down to the Values or Patterns reports for an individual column from a synonym or
segment’s Data Profiling report.

How to View Data Profiling for a Synonym or SegmentProcedure:

To view the data profiling information for a synonym or segment’s columns:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens to the Tree View tab.
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2. Right-click the synonym or segment name and, select Data Profiling.

The Data Profiling information displays in the workspace.

You may use the data profiling results toolbar to view server messages, print the report,
copy data as text, and export the report.

3. Optionally, you can click a column name or patterns count (for alphanumeric columns)
to drill down to the Values or Patterns reports, respectively.

Describing Data with Graphical Tools 163

4. Analyzing Metadata and Procedures



This is a Values report produced by clicking a column name.

This is a Patterns report produced by clicking a Patterns Count value.

The image below is an example of an address column.

For pattern analysis, a "9" represents a digit, an "A" represents any upper case letter,
and an "a" represent any lower case letter. All printable special characters are
represented by themselves, and unprintable characters are represented by an "X".

Data Profiling a Single Column

How to:

View Data Profile Statistics

View Data Profile Patterns

View Data Profile Values

View Data Profile Outliers

Data Profiling for an individual column provides access to four reports:

Statistics shows the same information as a Data Profile report for a synonym or segment.

For alphanumeric columns, the Statistics report provides the segment, format, count of
distinct values, total count, patterns count, maximum, minimum, and average length,
and number of nulls.
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For numeric columns, the Statistics report provides the segment, format, count of distinct
values, total count, maximum, minimum, and average value, and number of nulls.

Patterns, which is only available for alphanumeric columns, shows patterns of letters,
digits, and special characters, as well as counts and their percent.

Values shows unique values and their percents.

Outliers shows the ten highest and lowest values and their counts.

These reports are available by right-clicking a column in the Synonym Editor and selecting
Data Profiling.

The Patterns report shows the number of patterns found for each alphanumeric column.

Clicking on a patterns count displays the actual patterns.
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The image below is an example of an address column.

For pattern analysis, a "9" represents a digit, an "A" represents any upper case letter, and
an "a" represent any lower case letter. All printable special characters are represented by
themselves, and unprintable characters are represented by an "X".

How to View Data Profile StatisticsProcedure:

To view the statistical data profiling information for a single column:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens to the Tree View tab.

2. Right-click a column and, select Statistics from the Data Profiling submenu.
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The Statistical Data Profiling information displays in the workspace.

3. Optionally, you can click a column name or patterns count (for alphanumeric columns)
to drill down to the Values or Patterns reports, respectively.

How to View Data Profile PatternsProcedure:

Data Profile Patterns shows patterns of letters, digits, and special characters, as well as
counts. This is only available for alphanumeric columns.

To view the patterns data profiling information for a single column:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens to the Tree View tab.
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2. Right-click a column and, select Patterns from the Data Profiling submenu.

The Patterns Data Profiling information displays.

For pattern analysis, a "9" represents a digit, an "A" represents any upper case letter, and
an "a" represent any lower case letter. All printable special characters are represented by
themselves, and unprintable characters are represented by an "X".

How to View Data Profile ValuesProcedure:

Data Profile Values shows unique values.

To view the values data profiling information for a single column:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens to the Tree View tab.
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2. Right-click a column and, select Values from the Data Profiling submenu.

The Values Data Profiling information displays.

How to View Data Profile OutliersProcedure:

Data Profile Outliers shows the 10 highest and lowest distinct values.

To view the outliers data profiling information for a single column:

1. From the Projects or Data Servers area in Developer Studio, open a synonym by
double-clicking a Master File from the Master Files folder.

The Synonym Editor opens to the Tree View tab.
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2. Right-click a column and, select Outliers from the Data Profiling submenu.

The Outliers Data Profiling information displays.

Note: Outliers produce a maximum of 10 highest and lowest distinct values, if they
exist.
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Adding Data and Rebuilding FOCUS Data
Sources

5

Topics:
If you choose to create a Master File
schema before the corresponding FOCUS
data source has been created, you will
need to create and populate the FOCUS
data source before you can use it in
reports or other requests. For details
about creating a Master File, see Using
the Synonym Editor on page 51.

Creating a FOCUS Data Source

Rebuilding a Data Source

Furthermore, if you modify a Master File
in the course of your work, you can
rebuild the corresponding data source
using a graphical Rebuild utility.
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Creating a FOCUS Data Source

How to:

Create a Data Source

When you save a Master File, you must also create a corresponding blank data source that
will hold the data for the fields defined in the Master File. This data source is saved in the
application directory.

After creating the blank data source, you can load data into it with a MODIFY request, or a
Maintain request. After you populate the data source, you can use it in conjunction with the
Master File in a report request.

How to Create a Data SourceProcedure:

1. From the Projects or Data Servers area in Developer Studio, right-click the Master Files
folder, and select Synonym via Synonym Editor from the New menu.

2. Type in a File name in the Add Master File dialog box and click Open.

The Master File opens to the Modeling View tab in the Synonym Editor.

3. Create and save the synonym.

4. Click Close from the File menu.

5. Click Yes to create a blank FOCUS (.foc) database file.

FOCUS creates a blank data source (.foc) in the background.

The .foc file is stored in the application directory.
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Rebuilding a Data Source

In this section:

Rebuilding a Disorganized File

Rebuilding the Index

Checking the Integrity of a Data Source

How to:

Use the Rebuild Utility

Reference:

Rebuild Dialog Box

The Rebuild tool provides a number of useful project management utilities. Rebuild enables
you to restructure data sources, rebuild indexes, and check the integrity of data sources.

Note: You can only use this utility with FOCUS data sources.

How to Use the Rebuild UtilityProcedure:

To open the Rebuild dialog box:

1. Choose Utilities from the Command menu, then choose Rebuild from the cascading
menu.

The Rebuild dialog box opens.

2. Select a Rebuild option.

See Rebuild Dialog Box on page 174 and individual procedures for each of the Rebuild
options.
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Rebuild Dialog BoxReference:

Choose Utilities from the Command menu, and Rebuild from the Utilities cascading menu
to display the Rebuild dialog box. The Rebuild dialog box has the following fields/options:

Rebuild a disorganized file

This option can be used to perform the following functions:

Re-optimize a FOCUS data source after a large amount of data has been added or
deleted.

Select specific segment instances to include in the data source, based on record
selection criteria you specify.

Index a field

Builds or rebuilds the index for the specified field. Use this option to index an additional
field that was not originally specified as an index field, or to change the index for a field.
See Rebuilding the Index on page 175.

Check the integrity of a file

Checks the structural integrity of a data source. If FOCUS encounters an error during the
check, it displays a message. See Checking the Integrity of a Data Source on page 176.

Filename

Contains the name of the data source to rebuild. Enter a data source name in the box,
or click the Browse button to open a dialog box and select the data source.

Selection Criteria

Specifies selection criteria for rebuilding a disorganized data source and reorganizing a
data source to fit a new Master File. Only data that meets the selection criteria is included
in the rebuilt data source.

Rebuilding a Disorganized File

This option in the Rebuild dialog box enables you to:

Restructure and optimize a FOCUS data source after data has been added or deleted.

Select specific segment instances for inclusion in the data source based on selection
criteria you supply. For example, if you specify the following selection criterion,

INVOICE_DATE GT 990101

FOCUS will omit invoices earlier than 99/01/01 from the rebuilt data source.

174 WebFOCUS7

Rebuilding a Data Source



Rebuilding the Index

How to:

Index a Field After Data Is Entered

Rebuild the Index

When you first create a Master File in the Synonym Editor, you specify the fields that you
want indexed. Sometimes, after data is entered, you may need to index an additional field
that was not originally specified as an index field.

The first step is to alter the Master File to indicate that the field should be indexed. Altering
the Master File does not actually create the index. To do this you must use the Rebuild utility
after you index a field.

How to Index a Field After Data Is EnteredProcedure:

From the Synonym Editor, select the field to be indexed, and then click the I- Index check
box under the FIELDTYPE attribute.

or

Open and edit the Master File as text in the Text Editor. For instructions on indexing a field
as text, see the Describing Data With WebFOCUS Language manual.

After you index a field you must rebuild the index. See How to Rebuild the Index on page 175.

How to Rebuild the IndexProcedure:

1. Select Index a field in the Rebuild dialog box.

2. Enter a data source name in the Filename box or click Browse and select a data source
from the list.

3. Enter the name of the field you want to index in the Field to Index box.

To index all the fields designated as index fields in that data source, enter an asterisk
(*) in the Field to Index box.

4. Click OK.

The Rebuild utility rebuilds the data source, creating an index for all specified fields.

For more information on indexing fields, see the Describing Data With WebFOCUS Language
manual.
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Checking the Integrity of a Data Source

How to:

Check the Structural Integrity of a FOCUS Data Source

It is rare for the structural integrity of a FOCUS data source to be damaged. Structural damage
will occasionally occur, however, during a disk drive failure or if an incorrect Master File is
used. In this situation, you can check the integrity of the Master File. Checking the integrity
of a Master File performs the following essential tasks:

It checks all pointers in the data source.

Should it encounter an error, it displays a message and attempts to branch around the
offending segment or instance. In this way, it recovers as much of the data source as
possible.

Although checking the integrity reports on a good deal of data that would otherwise be lost,
it is important to remember that frequently backing up your FOCUS data sources is the best
method of preventing data loss.

Checking the Master File integrity will occasionally fail to uncover structural damage. If you
have reason to believe that there is damage to your data source, though results from checking
the integrity indicates otherwise, there is a second method of checking file integrity. This
method uses the ? FILE and TABLEF commands. For more information, see the Describing
Data With WebFOCUS Language manual.

How to Check the Structural Integrity of a FOCUS Data SourceProcedure:

Select Check the integrity of a file in the Rebuild dialog box.

If the Rebuild utility encounters an error during the check, it logs a message for you. You
should then attempt to recover as much of the data source as possible or restore it from
backup.
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